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Quick Start to Network
Administration

Network deployment of this program requires careful planning and execution. This section
gives you quick, step-by-step instructions about how to prepare for deployment, set up a
license server, and set up and distribute the program.

If you are not familiar with network administration and deployment, you should read the
entire Network Administrator's Guide before you attempt to deploy and administer the program
over a network.

How to Prepare for Deployment

To prepare for a deployment, you need to choose an installation type and a
license server model.

How to Choose an Installation Type

When you set up your deployment, you need to choose the type of installation
to deploy. In the AutoCAD Architecture 2009 Installation wizard, you specify
one of the following installation types:

Network License installation With this type of installation, you install the
program to workstations with the files and registry entries that allow the program
to communicate with the Network License Manager. You also define the
configuration of the Network License Manager so that the licenses can be
accessed. Workstations running the program based on a network installation
do not require individual activation. Licensing of this program is managed by
at least one license server.



The main advantage is that you can install AutoCAD Architecture on more
systems than the number of licenses you have purchased (for example,
purchasing 25 licenses but installing on 40 workstations). At any one time,
AutoCAD Architecture runs on the maximum number of systems for which
you have licenses. This means you get a true floating license.

Multi-Seat Stand-Alone installation (Stand-Alone option) Choose this type
of installation for stand-alone installations where a single serial number is
used for multiple seats. Multi-seat stand-alone installations do not rely upon
a Network License Manager to manage product licenses; however, you can
still use the AutoCAD Architecture 2009 Installation wizard to create
administrative images and create deployments. Registration and activation is
more automated for multi-seat stand-alone installations. After the first
activation using the multi-seat stand-alone serial number, activation occurs
automatically for all workstations based on this deployment, as long as your
systems are connected to the Internet.

Stand-Alone installation (Stand-Alone option) Choose this type of
installation for stand-alone installations where a single serial number is used
for a single seat. Like a multi-seat stand-alone installation, you do not use the
Network License Manager to manage product licensing, but installation,
registration, and activation occurs on each workstation.

If you choose one of the Stand-Alone installation types, you can proceed to
the section How to Set Up and Distribute the Program on page 9.

How to Choose a License Server Model

If you chose the Network Installation option, you need to decide which license
server model to use to distribute the product licenses.

TIP If you are deploying a stand-alone or multi-seat stand-alone installation type,
you do not use a license server model. Proceed to the How to Set Up and Distribute
the Program on page 9 section.

For the network installation, use one of the following license server models:

B Single license server model. The Network License Manager is installed on
a single server, so license management and activity is restricted to this
server. A single license file represents the total number of licenses available
on the server.

B Distributed license server model. Licenses are distributed across more than
one server. A unique license file is required for each server. To create a
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distributed license server, you must run the Network License Manager on
each server that is part of the distributed server pool.

B Redundant license server model. You use three servers to authenticate a
single license file. One server acts as the master, while the other two provide
backup if the master server fails. With this configuration, licenses continue
to be monitored and issued as long as at least two servers are still functional.
The license file on all three servers is the same. You must install the
Network License Manager on each server.

Each of these license server models is described in detail in the Network Licensing
Guide. It is strongly recommended that you read that guide before you deploy
the program. You can find the Network Licensing Guide by clicking the
Documentation link at the lower left corner of the AutoCAD Architecture
2009 Installation wizard and in the Help system.

How to Set Up a License Server

If you are planning to have users run the program using network licenses, you
need to use the Network License Manager and the Network License Activation
utility.

The Network License Manager helps you configure and manage license servers.
The Network License Activation utility helps you get licenses and register
them over the Internet.

How to Install the Network License Manager

The Network License Manager is used to configure and manage the license
servers.

To install your Network License Manager

1 In the AutoCAD Architecture 2009 Installation wizard, click Install Tools
and Utilities.

2 On the Select the Products to Install page, select Autodesk Network License
Manager and click Next.
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3 Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

4 On the Review - Configure - Install page, review your product selection
and the current settings. If you don’t want to make any changes, click
Install. If you want to change the install type or installation path, click
Configure.

5 On the Select the Installation Type page, choose Typical or Custom and
accept the default installation path (C:\Program Files\ Autodesk Network
License Manager\) or Browse to specify a different path. If you enter a path
that does not exist, a new folder is created using the name and location
you provide. Click Next.

WARNING Do not install the Network License Manager on a remote drive.
When you install the Network License Manager files, you must provide a path
to a local drive. You must specify the drive letter; the universal naming
convention (UNC) is not supported.

6 On the Configuration Complete page, click Configuration Complete to
return to the confirmation page.

7 On the Review - Configure - Install page, click Install.

8 When the Installation Complete page displays, click Finish.

How to Install and Use the Network License
Activation Utility

With the Network License Activation utility, you can obtain licenses over the
Internet, which saves time and effort in setting up a network-licensed version
of the program. In addition, you can register your product, get automated
support by email if you cannot obtain a license over the Internet, and save
and migrate license files automatically.
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To install your Network License Activation utility

1

In the AutoCAD Architecture 2009 Installation wizard, click Install Tools
and Utilities.

On the Select the Products to Install page, select Autodesk Network License
Activation utility and click Next.

Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

On the Review - Configure - Install page, review your product selection
and the current settings. If you don’t want to make any changes, click
Install. If you want to change the install type or installation path, click
Configure.

On the Select the Installation Type page, choose Typical or Custom and
either accept the default installation path (C:\Program Files\ Autodesk
Network License Manager\Network License Activation Utility \enu\) or Browse
to specify a different path. If you enter a path that does not exist, a new
folder is created using the name and location you provide. Click Next.

On the Configuration Complete page, click Configuration Complete to
return to the confirmation page.

On the Review - Configure - Install page, click Install.

When the Installation Complete page displays, click Finish.

To use your Network License Activation utility

1

Click Start menu » Programs (Windows XP) or All Programs (Windows
Vista) » Autodesk » Network License Manager » AutoCAD
Architecture 2009 Network License Activation Utility.

On the Obtain a Network License page, review how this utility works and
the requirements for using it, and then click Next.

On the Server Information page, enter the product serial number.
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NOTE If you are modifying an existing license file or obtaining a new license
for an existing product, your previously entered information might be
displayed. Make sure that the serial number that is displayed is the one you
want to license. If it is not, enter the correct product serial number.

In the License Server Model section, click a license server model. For more
information about each license server model, click the ? button.

In the Server Host Name box, enter a server host name or click the [...]
button to locate the name of each server you plan to use.

In the Host ID box, for each server host name you entered in the previous
step, click Lookup to have the utility automatically locate the host ID for
the server, or enter the host ID manually.

NOTE If your server has more than one network adapter, select the one that
corresponds to a physical network adapter. To determine which adapters are
physical, enter ipconfig /all at a Windows command prompt and view the
Description field above each physical address. If there is more than one
physical network adapter, you can use any one of them, as long as it was
listed when you ran ipconfig /all. Logical devices such as VPN adapters, PPP
adapters, and modems may be listed but are not usable for licensing.

If you chose Distributed Server in step 4, the Seats box is displayed. In
the Seats box, enter the number of seats for each license server, and then
click Next.

On the Confirm Server Information page, review the server information
you entered, and click Next.

If the Register and License Your Autodesk Product page is displayed, do
all of the following, and then click Next.

B In the This Product Is To Be Registered To option, select Company or
Individual.

B In the Select Country or Region section, select your country or region
of residence.

B In the Is This an Upgrade section, select Yes or No.

If the Registration Information page is displayed, enter your registration
information, and then click Next.

If the Confirm Information page is displayed, review your registration
information, and then click Next.
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12 If the Connecting page is displayed, click Next to connect to the Internet
to obtain your network license.

13 On the Licenses Received page, in the Save License File for [computer name]
dialog box, enter the location where you want to save your license file,
or click Browse to navigate to the location.

NOTE It is recommended that you save your license file to the location where
you installed the Network License Manager.

14 If you have an existing license file from another Autodesk product, select
one of the following options:

H Insert the New License Information Into It. The new license
information is added into the existing license file.

B Overwrite the Existing License File. The entire contents of the existing
license file is replaced with the new license information. Select this
option only if you no longer require any part of the existing license
file contents.

15 Click Next.

16 On the License Activation Successful page, click Print to save a printed
copy of the license information, or click Done to complete the transaction
and exit the Network Activation utility.

How to Configure Your License Server

You configure a license server so that you can manage the Autodesk product
licenses you received when you ran the Network License Activation utility.
Configure the license server with the Imtools.exe utility.

To configure your license server

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Do one of the following:

B Click Start menu » Programs (Windows XP) or All Programs
(Windows Vista) » Autodesk » Network License Manager »
LMTOOLS.
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B Right-click the LMTOOLS icon (Windows Vista) on the desktop and
click Run As Administrator.

In the Lmtools program, on the Service/License File tab, select the
Configure Using Services option.

Click the Config Services tab.

On the Config Services tab, in the Service Name list, select a service name

or do one of the following:

B If a service name is selected, verify that it is the one you want to use
to manage licenses.

B If no service name exists, enter the service name you want to use to
manage licenses.

NOTE If you have more than one software vendor using FLEXIm® for license
management, the Service Name list contains more than one option.

In the Path to Lmgrd.exe File box, enter the path to the Network License
Manager daemon (Imgrd.exe), or click Browse to locate the file.

By default, this daemon is installed in the \Program Files\ Autodesk Network
License Manager folder.

In the Path to the License File box, enter the path to your license file, or
click Browse to locate the file.

In the Path to the Debug Log File box, enter a path to create a debug log,
or click Browse to locate an existing log file.

To run Imgrd.exe as a service, select Use Services.

To automatically start Imgrd.exe when the system starts, select Start Server
at Power Up.

Click Save Service to save the new configuration under the service name
you selected in step 4. Then click Yes.

Click the Start/Stop/Reread tab.

On the Start/Stop/Reread tab, do one of the following:

B If a service has not yet been defined for Autodesk, click Start Server
to start the license server.
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B If a service for Autodesk is already defined and running, click ReRead
to refresh the Network License Manager with any changes made to
the license file or Options file.

The license server starts running and is ready to respond to client
requests.

13 Close Imtools.exe.

How to Set Up and Distribute the Program

Once you have prepared for deployment and you have used the Network
License Manager and the Network License Activation utility, you are ready to
set up and distribute this program by using the AutoCAD Architecture 2009
Installation wizard and choosing a deployment method.

How to Create a Network Share

A network share is an installation folder that you make available to users'
computers on a network. You point users to this location to install the program.
Create a network share that will be used by the AutoCAD Architecture 2009
Installation wizard during the creation of a client deployment.

NOTE You must have Full Control permissions set for your shared folder when
you are creating your deployment images. Read permissions are necessary to
access the network share and administrative permissions on the workstation where
the program is deployed.

To create your network share

1 On the desktop of a network server, create a folder named Autodesk.
2 Right-click the Autodesk folder and click Share and Security (or Sharing).

3 In the <folder name> Properties dialog box, Sharing tab, select Share This
Folder.

4 Specify a Share Name, such as Autodesk or MyDeployments, if necessary.

5 Click the Permissions button. In the Permissions dialog box make sure
Full Control is active. Click OK.
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In Vista, right-click the Autodesk folder and then click Share. In the
Properties dialog box select Sharing and then Advanced Sharing to share
the folder. Click the Permissions button to make sure Full Control is
active. Click OK.

These steps are important when creating your deployment images.
6 Click OK or Close to close the Properties dialog box.

7 For each product you plan to install, create a subfolder in the Autodesk
folder. Name each folder with the pertinent product name.

How to Use the Installation Wizard to Set Up a
Deployment
You can create a deployment directly from the AutoCAD Architecture 2009

Installation wizard. From the deployment, users can install the program on
their computers.

NOTE The following procedure illustrates just one of the ways you can set up a
deployment. This procedure details a single-server network deployment with a
Typical client setup type and no customizations. For further information about
setting up deployments, see Use the Installation Wizard to Set Up a Deployment
on page 31.

To use the Installation wizard to create a default deployment

1 In the AutoCAD Architecture 2009 Installation wizard, click Create
Deployments.

2 On the Begin Deployment page, you need to specify the following:
administrative image location, deployment name, and if your target
systems are 32 or 64-bit operating system(s).

B In the administrative image field, enter an existing shared network
location where you want to create an administrative image, or click
the Browse button to navigate to a location where there is a shared
network location. Users install the program from this location.

NOTE If you do not know how to create a network share, see How to
Create a Network Share on page 9.
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B In the deployment name field, enter the new deployment's name.
The name you enter here is the name of the shortcut your users will
access to install the product.

B Under This Is To Be A, choose whether your deployment is going to
be installed on a 32-bit or a 64-bit target operating system. This
selection does not identify the system your deployment was created
on; it identifies your target system.

Click Next.

On the Select the Products to Include in the Deployment page, choose
the product(s) you want to deploy and click Next.

NOTE AutoCAD Design Review 2009 is not installed by default when you
install AutoCAD Architecture. Some AutoCAD Architecture features require
that Design Review be installed to work properly. Design Review is the
replacement viewer for DWF Viewer. For more information about the affected
features, see Features That Require Design Review on page 19

Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

On the Product and User Information page, enter your serial number and
user information and click Next.

IMPORTANT The information you enter here is permanent and is displayed
in the AutoCAD Architecture 2009 window (accessed by Menu browser »
Help » About or Help » About) on your computer. Because you can't
change this information later without uninstalling the product, make sure
you enter the correct information now.

On the General Deployment Settings page, choose if you want the
deployment to create a network log and/or a client log, run the client
installation in silent mode, and if you want users to participate in the
Customer Involvement program.

B When you choose to create a network log file, you also have to specify
where the log file is created by entering either a valid UNC (universal
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naming convention) path or hard-coded path on your network. The
network log file is optional.

NOTE The folder where the network log resides must be a shared folder
where users who install the program have Change permissions. Otherwise,
successes or failures for user installations cannot be written to the log file.

B Choose whether you want a client log file created.

B If you want to prevent users from changing installation settings when
they install, select Silent mode.

m If you choose participation in the Customer Involvement program,
Autodesk sends helpful information about the product.

For more information regarding log files, refer to Specify Log File Locations
on page 35.

Click Next.

7 On the Review - Configure - Create Deployment page, click Create
Deployment.

By clicking Create Deployment, an administrative image is created in the
shared folder using the deployment options listed in the Current Settings
field.

8 On the Deployment Complete page, click Finish.

To use the Installation wizard to create a configured deployment

1 In the AutoCAD Architecture 2009 Installation wizard, click Create
Deployments.

2 On the Begin Deployment page, specify the following: the administrative
image location, deployment name, and if your target systems are 32 or
64-bit operating system(s).

B In the Administrative Image field, enter an existing shared network
location where you want to create an administrative image, or click
the Browse button to navigate to a location where there is a shared
network location. Users install the program from this location.

NOTE If you do not know how to create a network share, see How to
Create a Network Share on page 9.
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B In the Deployment Name field, enter the new deployment's name.
The name you enter here is the name of the shortcut your users will
access to install the product.

B Under This Is To Be A, choose whether your deployment is going to
be installed on a 32-bit or a 64-bit target operating system. This
selection does not identify the system your deployment was created
on; it identifies your target system.

Click Next.

On the Select the Products to Include in the Deployment page, choose
the product(s) you want to deploy and click Next.

NOTE AutoCAD Design Review 2009 is not installed by default when you
install AutoCAD Architecture. Some AutoCAD Architecture features require
that Design Review be installed to work properly. Design Review is the
replacement viewer for DWF Viewer. For more information about the affected
features, see Features That Require Design Review on page 19

Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

On the Product and User Information page, enter your serial number and
user information and click Next.

IMPORTANT The information you enter here is permanent and is displayed
in the AutoCAD Architecture 2009 window (accessed by Menu browser »
Help » About or Help » About) on your computer. Because you can't
change this information later without uninstalling the product, make sure
you enter the correct information now.

On the General Deployment Settings page, choose if you want the
deployment to create a network log and/or a client log, run the client
installation in silent mode, and if you want users to participate in the
Customer Involvement program.

B When you choose to create a network log file, you also have to specify
where the log file is created by entering either a valid UNC (universal
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naming convention) path or hard-coded path on your network. The
network log file is optional.

NOTE The folder where the network log resides must be a shared folder
where users who install the program have Change permissions. Otherwise,
successes or failures for user installations cannot be written to the log file.

B Choose whether you want a client log file created.

B If you want to prevent users from changing installation settings when
they install, select Silent mode.

m If you choose participation in the Customer Involvement program,
Autodesk sends helpful information about the product.

For more information regarding log files, refer to Specify Log File Locations
on page 35.
Click Next.

7 On the Review - Configure - Create Deployments page, click Configure
to make changes to the administrative image.

8 On the Select the License Type page, select a Stand-alone or Network
license installation.

9 On the Select the Installation Type page, you can choose to make the
following configuration changes:

B Typical - Installs the most common application features.

B Custom - Installs only the application features that you select from
the Select Features To Install list:

CAD Standards Contains tools for reviewing design
files for compliance with your stan-
dards.

Database Contains database access tools.

Dictionaries Contains multilanguage dictionaries.

Drawing Encryption Allows you to use the Security Options
dialog box to protect a drawing with
a password.

14 | Chapter | Quick Start to Network Administration
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Fonts

Contains program fonts. (True Type
fonts are automatically installed with
the program.)

Content Search

Allows you to search for installed Auto-
CAD Architecture content.

Portable License Utility

Contains a tool for moving a stand-
alone license between computers.

Migrate Custom Set-
tings

Allows you to migrate custom settings
and files from previous releases. For
more information, see Migrate Custom
Settings.

Reference Manager

Allows you to view and edit the paths
of externally referenced files associated
with a drawing.

Samples Contains various feature sample files.
Tutorials Contains product lessons.
VBA Support Contains Microsoft Visual Basic for

Applications support files.

B Product Install Path - Specifies the drive and location where AutoCAD
Architecture will be installed.

Click Next to proceed with the configuration process.

On the Configure Content Packs page, you can select Content Packs,
which are collections of locale- and discipline-specific profiles and content
files, to install with AutoCAD Architecture. You can opt to install an
AutoCAD-only profile and desktop shortcut. You can also specify a new
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location for the Content Browser library file. After making your selections,

click Next.

J famnmjih[l Architecture 2009 [ |

Information

= What iz & Content Pack?

* Can | add or remove Content Packs
at a later date?

* Howe do | create an SutaCaD
profile?

®What iz & Content Broweser Library
file?

Configuration Progress: Page 3 of 5

Configure Content Packs

Content Pack
AutoCAD Profile

AutoCAD 2009
Architecture

US Imperial
1S Mekric
[0 bacH

Desktop Shortcut

b,

[Itodify Content Browser Library file location

Disk space requirements

Valu, .. Disk Size | Available | Required Total Required | Remaining | |#
s 93.1 GB 7358 GE 1.11 GB 1.11 GB 727 GB L
F: 349 GE 274 GB 0 bytes 0 bytes 274 GB b
[H 269 66 145 GE 0 bytes 0 bytes 145 GE
I 269 66 145 GE 0 bytes 0 bytes 145 GE V]

Back

11 The Configurable Folders page allows you to specify custom locations for
groups of content. For example, you may wish to share layer standards
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between users, allowing standards to be updated from one location. After
making your selections, click Next.

J famnoijih[l Architecture 2009 & |

Information Configurable Folders

Group Mode Path

= Wbt can Configurable Folders do Support

far me? s

Menus Default

* What iz contained in each group? Plotters Default
Flot Styles Default

* What are Modes?

Content

= What does the Append hutton do? AEC Styles and ... Default
Tool Catalogs Default
Templates Default

[ S [y

Disk space requirements:

Walu, .. Disk Size | Available | Required Total Required | Remaining
s 93,1 GB 73.8GE 1.11 GE 1.11 GB 727 GB
F: 349 GB 2.74 GB 0 bytes 0 bytes 2.74GB
[H 269 GB 145 GB 0 bytes 0 bytes 145 GE
I 269 GB 145 GB 0 bytes 0 bytes 145 GE
Configuration Progress: Page 4 of 5
Back

(2]

Append

On the Define Search Paths and File Locations page, define search paths,
file names, and file locations, and then click Next.

WARNING Do not remove the DRV path and always add paths as secondary
paths.

To include additional files in the deployment, select their location and
file names on the Install Additional Files page. After making your
selections, click Next.

On the Specify User Preferences page, decide if the Internet Explorer
browser is required, set the default profile name, and whether or not you
want a desktop shortcut. Click Next.

On the Include Service Packs page, if service packs are available for your
deployment, you can select to include them.

The installer automatically checks autodesk.com for available updates. If
updates are available, a link is displayed. If no updates are available a link
is not displayed.

How to Use the Installation Wizard to Set Up a Deployment | 17
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On the Configure InfoCenter Communications Center page, you choose
to allow users access to the latest information and product discussions
by enabling live updates from Autodesk, Information and CAD Manager
channels and RSS feeds. After making your choices, click Next.

You can also allow users access to online tools such as DesignCenter,
error reporting and InfoCenter searches on the Configure Access to Online
Resources page. Make your selections, and then click Next.

On the Configuration Complete page, select another product tab to
configure another product and then click Next, or click Configuration
Complete to review your choices.

On the Review - Configure - Create Deployment page, click Create
Deployment.

On the Deployment Complete page, click Finish.

How to Deploy This Program

You can choose from several methods of deploying the program. Network
sharing is the default method.

18 | Chapter |

Network Share. Users launch the program with the shortcut icon that you
created with the Installation wizard, in step 3 of the procedure How to Use
the Installation Wizard to Set Up a Deployment on page 10. The program
is installed on users' local computers, and a product icon appears on their
desktop.

NOTE Users must have Read permissions to access the network share and
administrative permissions on the workstation where this program is installed.

Scripting. See Use Scripts to Deploy the Program on page 67.

Group Policy Objects (GPOs). See Use Group Policies to Install a
Deployment on page 79.

Imaging Software. See Distribute the Product Using Imaging Software on
page 101.

Quick Start to Network Administration



Features That Require Design Review

Design Review is a tool for reviewing and working with DWF files. DWF files
are drawing files that have been converted so they can be transported over
the Internet and then shared with others. In order to work with DWEF files,
you need to have Design Review installed.

If you want to use any of the following commands or functions with a DWF
file, you neeed to have Design Review installed.

B PROJECT NAVIGATOR
m PUBLISH

m PLOT

m 3DDWF

m PUBLISH TO WEB

B EXPORT

® MARKUP

B DWFUNDERLAY

m AUTOPUBLISH

|

SSM
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System Requirements

This section contains the system requirements for the location of the administrative image
that you create, the network license server, and the client workstation.

System Requirements for This Program

Before you begin installing the program on a network, make sure that your
servers and client workstations meet the minimum recommended hardware
and software requirements for a deployment.

You choose to install either the 32-bit or 64-bit version of AutoCAD Architecture,
depending on your operating system.

See the following tables for administrative image, license server, and client
workstation system requirements.

Hardware and software requirements for the location of the administrative

image

Hardware/Soft- Requirement Notes

ware

Hard disk 1 GB or above (recommended) The location where you

create the administrative
image must be a shared lo-
cation so that users can ac-
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Hardware and software requirements for the location of the administrative

image

Hardware/Soft-
ware

Requirement

Notes

cess the administrative im-
age.

Hardware and software requirements for the network license server

Hardware/Soft-
ware

Requirement

Notes

Operating system

Windows Vista 32-bit
Windows XP 32-bit
Windows 2003 Server Edition

The Network License Man-
ager supports Ethernet net-
work configurations only.

Computer/proces-
sor

Intel® Pentium® IV, 3.0 GHz or
faster (recommended)

AMD® Athlon®, 3.0 GHz or faster
(recommended)

Intel® Pentium® Il or later (mini-
mum)

Network interface
card

Compatible with existing Ethernet
network infrastructure

The Network License Man-
ager supports multiple net-
work interface cards.

Communication
protocol

TCP/IP

The Network License Man-
ager uses TCP packet types.

Hardware and software requirements for client machine

Hardware/Soft-
ware

Requirement

Notes

Operating system

32-Bit

Windows XP Professional, SP2
(recommended)

Windows Vista Ultimate

22 | Chapter 2 System Requirements
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Hardware and software requirements for client machine

Hardware/Soft-
ware

Requirement

Notes

Windows Vista Enterprise
Windows Vista Business

Windows Vista Home Premium
64-Bit

Windows XP Professional x64, SP2
Windows Vista Ultimate

Windows Vista Enterprise
Windows Vista Business

Windows Vista Home Premium

ating system with a user in-
terface language that
matches the code page of
the AutoCAD Architecture
language. A code page
provides support for charac-
ter sets used in different
languages.

For more information about
Windows Vista versions,
please see htp://www.mi-
crosoft.com/windowsvista/ver-
sions

Web browser

32-bit

Microsoft® Internet Explorer 6.0,
SP1 (or later)

64-bit

Microsoft® Internet Explorer 6.0,
SP1 (or later)

You cannot install AutoCAD
Architecture if Microsoft In-
ternet Explorer 6.0, SP1 (or
later) is not installed on the
installation workstation. You
can download Internet Ex-
plorer from the Microsoft
website: http://www.mi-
crosoft.com/downloads/

Processor

32-bit

Intel® Pentium® IV, 3.0 GHz or
faster (recommended)

AMD® Athlon®, 3.0 GHz or faster
(recommended)

64-bit

AMDE® Athlon® 64

AMD® Opteron®

Intel® Xeon® with Intel EM64T
support

Inte®l Pentium® IV with Intel
EM64T support

Multiple processors support-
edDual core supported
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Hardware and software requirements for client machine

Hardware/Soft- Requirement Notes
ware
Memory (RAM) 32-bit

2 GB (minimum), 3 GB (recom-

mended)

64-bit

2 GB (minimum), 4 GB (recom-
mended)

Display Resolution

32-bit

1024 x 768 True Color (mini-

mum)1280 x 1024 True Color
(recommended)

64-bit

1024 x 768 True Color (mini-

mum)1280 x 1024 True Color
(recommended)

Display Card

32-bit

128 MB Video Adaptor Card (mini-
mum)

256 MB or greater, Direct 3D
compatible 3D Video Adaptor Card
(recommended)

64-bit

128 MB Video Adaptor Card (mini-
mum)

256 MB or greater, Direct 3D
compatible 3D Video Adaptor Card
(recommended)

For more information about
currently supported video
cards, please see
http://usa.autodesk.com/ad-
SR B11280-671183SHD-P10618

Hard disk

32-bit

Default installation 2.0 GB
Full installation 2.5 GB
64-bit

Default installation 3.0 GB
Full installation 3.5 GB
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Hardware and software requirements for client machine

Hardware/Soft- Requirement Notes

ware

Pointing device MS-Mouse compliant For both 32-bit and 64-bit
DVD Any speed (for installation only) For both 32-bit and 64-bit
Optional hardware  Printer or plotter For both 32-bit and 64-bit

Internet access
Network interface card

System Requirements for This Program | 25
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Deploy the Program

In this section, you'll find more detailed information about using the Installation wizard to
create or modify deployments.

Preliminary Tasks for a Network Deployment

Installing this program on a network requires careful planning and execution.
The deployment checklist gives you a quick summary of the type of information
you should be familiar with during your deployments.

Deployment Checklist
D You have reviewed the system requirements. You must make sure that your

network, servers, and client workstations meet the system requirements. See
System Requirements for This Program on page 21.

You have closed all other programs and disabled anti-virus software. See Minimize
Chances of Installation Failure on page 29.
each program you plan to deploy. See Create Shared Folders for Your Deploy-

ments on page 29.

You have installed and activated any supporting tools and utilities. See Install

D You have identified where deployments will reside such as a shared folder for
D and Activate Tools and Utilities on page 30.

27



Deployment Checklist

D If your deployment plan involves using imaging software to distribute your
program(s) to client workstations, you have reviewed the Distribute the Product
Using Imaging Software on page 101 section.

D You have specified whether you want to create log files that contain deployment
and installation data, run silent mode, and participate in the Customer Involve-
ment Program. See Specify Log File Locations on page 35.

D You understand the type of license you’ve purchased. If you plan a network li-
cense deployment, you should also be familiar with the type of license server
model you want to use and the license server name(s). See Select a License Type
(optional) on page 36.

You know which type of installation you'll perform—typical or custom. See Select
the Installation Type (optional) on page 40.

You may want to set search paths to custom files or file locations that may have
changed in this release of software. See Define Search Paths and File Locations
(optional) on page 48.

You have decided if you want to include additional files with your deployment
such as drawing files, AutoLISP routines, or script files. See Install Additional Files
(optional) on page 49.

You have checked for service packs that might be available for your product. If
a service pack is available, you've downloaded it and extracted an MSP file. See
Include Service Packs (optional) on page 53.

You have configured access to Communication Center. Live Update notifications
let you know when product updates are posted and configuring Communication
Center lets users access technical information. See Configure InfoCenter Com-
munication Center (optional) on page 54.

a OO O O d

You have set up access and participation in features like DesignCenter Online,
Subscription Center, and Customer Error Reporting. See Allow Users to Access
Online Resources (optional) on page 57.

4
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Deployment Checklist

You know how you’re going to personalize the program(s) during registration.
Using consistent registration data is very important. See Register the Product on
page 62.

When you have completed these tasks, you are ready to create a deployment
from the Installation wizard.

Minimize Chances of Installation Failure

The AutoCAD Architecture 2009 installation process may stop if some
applications, such as Microsoft Outlook or virus checking programs, are
running when you are creating a deployment. Close all running applications
and temporarily disable virus checking utilities.

Create Shared Folders for Your Deployments

Shared folders are required for both network license and multi-seat stand-alone
methods of installation. The shared folder (network share) is created before you
run the Installation wizard and is where product deployments are stored.

It is recommended that you name the network share folder Deployments on
the desktop of the system where you want deployments stored. You can then
add subfolders inside the shared Deployments folder that clearly convey the
name of product you plan to deploy. This is also beneficial if you plan to
deploy multiple products.

47, Deployments
4 AutoCAD 2009
Adminlmage

AutoCAD Electrical 2009
Autodesk Impression
Design Review 2009
Inventor Pro 2009
Rewvit Structure 2009

Any subfolders that are placed inside a shared folder are automatically shared.

Minimize Chances of Installation Failure | 29



TIP You must have Full Control permissions set for your shared folder when you
are creating your deployment images. Read permissions are necessary to access
the network share and administrative permissions on the workstation where the
program is deployed.

To create a shared folder

On a network server, create a folder named Deployments.

Right-click the Deployments folder and click Share and Security (or Sharing).
In Vista, right-click the Deployments folder and then click Share. Click the
Permissions button to make sure Full Control is active.

In the <folder name> Properties dialog box, Sharing tab, select Share This
Folder.

In Vista, in the Properties dialog box, select Sharing and then Advanced
Sharing.

Specify a Share Name, such as MyDeployments, if necessary.

Click the Permissions button. In the Permissions dialog box make sure
Full Control is active. Click OK.

Click OK or Close to close the Properties dialog box.

For each product you plan to install, create a subfolder in the Deployments
folder. Name each folder with the pertinent product name.

Install and Activate Tools and Utilities

Several supporting tools and utilities are necessary if you plan to have users
run the program(s) with network licenses. Ancillary programs you might install
include:

30 | Chapter 3

Network License Manager
Network License Activation Utility
CAD Manager Tools

SAMreport Lite
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Refer to the Network Licensing Guide for detailed information about how to set
up your license servers. The Network Licensing Guide is available on the
Documentation link of the Installation wizard and in the Help system.

Use the Installation Wizard to Set Up a
Deployment
The deployment process is initiated from the Installation wizard. Deployments
are created from which users can install the program on their computers. You
make choices during the deployment process to create various client

deployment images and deployment types that meet user requirements and
company needs.

The deployment process lets you do any of the following:
Create a deployment.

Apply a patch to a deployment.

Customize locations for content folders.

Add customized files to a deployment.

Change search paths and file locations.

Allow users access to online resources.

NOTE Because the deployment process provides you with numerous options for
creating and customizing your deployments, there are many deployment pages
you need to complete and choices you must make. You should set aside ample
time to complete the deployment process in one sitting.

Start the Deployment Process

Once you start the Installation wizard, you initiate the deployment process
to set up a deployment.

To start the deployment process

B In the AutoCAD Architecture 2009 Installation wizard, click Create
Deployments.
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Create a Deployment

A deployment contains a Microsoft Transform (MST) file that modifies the
default behavior of the installation program. As you begin a deployment, you
need to select the location of your Administrative image, a deployment name,
and if your target systems are 32 or 64-bit operating systems.

Begin Deployment
Specify the Administrative Image location:

Browse...

Specify the new deployment name:

Thisis to be a:

To create a deployment

1 In the Installation wizard, click Create Deployments.

2 On the Begin Deployment page, enter the location of your Administrative
image or click the Browse button to locate your image. Enter your
deployment’s name, and if your target systems are 32 or 64-bit operating
systems.

NOTE The deployment location should be a shared network folder. To create
a shared folder, see Create Shared Folders for Your Deployments on page
29.

3 On the Select the Products to Include in the Deployment page, select the
products and click Next.

32 | Chapter 3 Deploy the Program



4 Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the deployment.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and want to terminate
the deployment process, click Cancel.

5 On the Product and User Information page, enter the serial number and
requested personalization data. Click Next.

6 On the General Deployment Settings page, choose whether or not you
want to create a network log and its location, and a client log. You can
also run the client’s installation in silent mode and if you want users to
participate in the Customer Involvement Program. Click Next.

7 If you do not want to make configuration changes on the Review -
Configure - Install page, click Create Deployment. Then select Yes, to
continue installing using the default configuration.

r "~ | You have not made changes to the default configuration that will be
- 4 used to install the chosen product(s).

Do you want to continue installing using the default configuration?

8 Select the Register products online link to register and activate your
product, or click Finish and register and activate later.

Enter Product and User Information

The Product and User Information page is used to personalize the program
for your company. The information you enter here is permanent and is
displayed in the About AutoCAD Architecture 2009 window (accessed by
Menu browser » Help » About) on all workstations that install your
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deployment. Because you can't change this information later without
uninstalling, make sure you enter the correct information now.

Product and User Information

Serial number:

123 - 12345678

First name:

MyMame

Last name:

MyMame

Organization:

MyQOrganization

You must also enter your product serial number in order to run the product.
The product serial number is located on the product packaging. The serial
number must contain a three-digit prefix followed by an eight-digit number.

To enter your serial number and personal information

1 On the Product and User Information page, enter your product serial
number and the requested personalization data.

NOTE Although it is required that you enter information in each box on this
page, you can enter any information that you want to convey to users who
install the deployment.

2 Click Next.
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Specify Log File Locations

The program has two types of log files with which you can monitor
information about deployments and installations.

General Deployment Settings

Log file

| Create network log

Specify the log file location:
VWMyComputer \Autodeskl<MyProduct = Browse. ..

| Create dient log
The dient log is created in the "Temp” directory of each dient workstation.

B Network log. The network log file keeps a record of all workstations that
run the deployment. On the General Deployment Settings page of the
deployment process, you choose whether or not to create a network log
file. The log lists the user name, workstation name, and the status of the
installation. Refer to this file for status information and details about
problems that users encountered during installation (for example, low disk
space or inadequate permissions). The network log is named with the same
name you chose for your deployment. You can specify where the log file
is created by entering either a valid UNC (universal naming convention)
path or hard-coded path on your network, for example
\\MyComputer\Autodesk\AutoCAD Architecture 2009.

NOTE The folder where the network log resides must be a shared folder where
users who install the program have Change permissions. Otherwise, successes
or failures for user installations cannot be written to the log file.

B Client log. The client log contains detailed installation information for
each workstation. This information may be useful in diagnosing installation
problems. The client log is located in the \Temp directory of each client
workstation.
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To specify a log file location

1 While creating a deployment, on the General Deployment Settings page,
select the check box next to the Create Network Log box. Enter the name
of the folder where you want the network log to be located.

2 If you want to create a client log, select the Create Client Log option.

3 Click Next.

What Is Silent Mode?

When silent mode is active and a user initiates the deployment, the installation
proceeds without any explicit user input. No dialog boxes are presented that
require interaction from the user.

Silent mode

| Client installations will be run in silent mode.

Customer Involvement Program (CIP)

If you choose to have your clients participate in the Customer Involvement
Program, AutoCAD Architecture will automatically send Autodesk information
about system configuration, what features you use most, any problems that
you encounter, and other information helpful to the future direction of the
product.

Customer Involvement

| Allow users to choose to partidpate in the Customer Involvement Program
{Recommended)

NOTE You can also enable or disable the Customer Involvement Program from
the CAD Manager Control utility.

Select a License Type (optional)

When you set up your deployment, you choose the type of installation to
deploy based on the type of software license you purchased: stand-alone or
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network. You also select the network license server model you want to use to
distribute product licenses.

Specify the license type to use during deployment

Stand-Alone license (a single serial number for a single seat) For a
stand-alone license, you install, register, and activate the program on each
workstation.

Network license With this type of installation, you install the program to
workstations with the files and registry entries that allow the program to
communicate with the Network License Manager. You also define the
configuration of the Network License Manager so that the licenses can be
accessed. Workstations running the program based on a network installation
do not require individual activation. Licensing of this program is managed
by at least one license server.

To deploy a stand-alone license

1 While creating a deployment, on the Select the License Type page, select
Stand-alone license.

Select the License Type
@ Stand-alone license

Metwork license

2 Click Next.

Specify the license server model during deployment

If you choose the Network license option, you need to decide which license
server model to use to distribute your product licenses - single, distributed or
redundant license server model.

If you are deploying a stand-alone or multi-seat stand-alone installation type,
you do not use a license server model. For more information on server models,
see How to Choose a License Server Model on page 2.

To deploy a network license using a single license server model

1 While creating a deployment, on the Select the License Type page, select
the Network License option.
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2 Select Single License Server as the license server model you want to use
with the Network License Manager.

If you have already used the Network License Manager to create a license
server model, you must select the same license server model in this step.
If you have not yet used the Network License Manager to create a license
server model, make sure that you select the same settings in the Network
License Manager that you choose here.

For detailed information about license server models, see “License Server
Models” in the Network Licensing Guide, located in the Help system and
on the Documentation link of the Installation wizard.

3 Enter the server name of the server that will run the Network License
Manager, or click the Browse button to locate the server. Click Next.

Select the License Type

) Stand-alone license

@ Metwork license

Select the license server model you will use with the Network License Manager:

Single License Server -

Enter the name of the server that will run the Netwark License Manager.

MLMSVR 1 Browse. ..

To deploy a network license using a distributed license server model

1 While creating a deployment, on the Select the License Type page, select
the Network License option.

2 Select Distributed License Server as the license server model you want to
use with the Network License Manager.

If you have already used the Network License Manager to create a license
server model, you must select the same license server model in this step.
If you have not yet used the Network License Manager to create a license
server model, make sure that you select the same settings in the Network
License Manager that you choose here.

For detailed information about license server models, see “License Server
Models” in the Network Licensing Guide, located in the Help system and
on the Documentation link of the Installation wizard.
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3 Enter the name of one of the servers that will run the Network License
Manager, or click the Browse button to locate the server. Click Add to
add the server to the Server Pool. Once all the servers are added to the
Server Pool list, use the Move Up and Move Down buttons to arrange the
servers in the order you want them to be searched by a user's workstation.
You must enter at least two servers. Click Next.

Select the License Type
() Stand-alone license
@ Metwork license

Select the license server model you will use with the Network License Manager:

Distributed License Server -

Enter the name of one of the servers that will run the Metwork License Manager
utility, and then dick Add to add the server to the server pool. Continue adding
server names until all the distributed license servers are listed.

Server name:
MLMSYR.3 Browse... Add

Server pool;

To deploy a network license using a redundant license server model

1 While creating a deployment, on the Select the License Type page, select
the Network License option.

2 Select Redundant License Server as the license server model you want to
use with the Network License Manager.

If you have already used the Network License Manager to create a license
server model, you must select the same license server model in this step.
If you have not yet used the Network License Manager to create a license
server model, make sure that you select the same settings in the Network
License Manager that you choose here.
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For detailed information about license server models, see “License Server
Models” in the Network Licensing Guide, located in the Help system and
on the Documentation link of the Installation wizard.

3 In the First Server Name field, enter a server name of one server that will
run the Network License Manager, or click the Browse button to locate
the server. Enter the server names for the remaining two servers that you
will use in the redundant server pool. Click Next.

Select the License Type
_) 5tand-alone license

@ Metwork license

Select the license server model you will use with the Network License Manager:

Redundant License Server -

Enter the name of the three servers that will form the redundant
server pool.

First server name:

MLMSVR1 Browse...

Second server name:

NLMSVR2 Browse...

Third server name:

Il

MNLMSVR3 Browse...

NOTE If you are not sure how to obtain the server host name, see “Plan Your
License Server Configuration” in the Network Licensing Guide. The Network
Licensing Guide is located in the Help system and on the Documentation link
of the Installation wizard.

Select the Installation Type (optional)

As part of making your deployment choices, you select the type of installation
that users receive when they install the program, choose which optional tools
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or features are included, and specify where the product is installed on each
workstation.

J fahum{ih[l Architecture 2009 [ |

Information Select the Installation Type ‘
A
(& Typical
*What iz in a typical installation? O Custom

Product install path:

C:YProgram Files\AutoCAD Architecture 2009, Browse. ..

Disk space requirements:

Valu, .. Disk Size | Available | Required Total Required | Remaining [+
s 93.1 GB 7358 GE 1.11 GB 1.11 GB 727 GB
F: 349 GE 274 GB 0 bytes 0 bytes 274 GB
[H 269 66 145 GE 0 bytes 0 bytes 145 GE
T NI 14AC O bk bk 14AC O

Configuration Progress: Page 2 of 5
( ) Back

B Typical. Installs the most common application features. This option is
recommended for most users.

B Custom. Installs only the application features that you select.

You choose the location where program files are installed on the client
workstation in the Product Install Path. To help decide where the product is
installed, a chart of drives and disk space is provided.

To deploy a typical installation, choose optional tools and specify a
product location

1 During the deployment, on the Select the Installation Type page, select
Typical as the type of installation that you want.

2 Enter the path on the client workstation where you want to install the
program, for example C:\Program Files\AutoCAD Architecture 2009, or click
the Browse button to specify the install location.

The Disk Space Requirements chart lets you review available drives and
disk space.
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3 Click Next.

To deploy a custom installation, choose optional tools and specify a
product location

1 During the deployment, on the Select the Installation Type page, select
the Custom option as the type of installation that you want.

J fahum{ih[l Architecture 2009 [ |

Information Select the Installation Type ‘
A
O Typical
*What iz in a typical installation? @ Custom
Select features to install: Feature description:
= (@ 4 Featurs |

: Contains all selectable features.
7 &, CAD Standards

7 &b Database

7| A, Dictionaries

7 & Drrawing Encryption
X Express Tools

7| A Fonts |
7 &, Content Search dl Restore Defaulks

Product install path:

C:YProgram Files\AutoCAD Architecture 2009, Browse. ..

Disk space requirements:

Valu, .. Disk Size | Available | Required Total Required | Remaining [+

s 93.1 GB 7358 GE 1.11 GB 1.11 GB 727 GB

F: 349 GE 274 GB 0 bytes 0 bytes 274 GB

[H 269 66 145 GE 0 bytes 0 bytes 145 GE v |

T NI 14AC O bk bk 14AC O L J
Configuration Progress: Page 2 of §

(NERRERRAEEE ) Back. Mext

2 From the Select Features to Install list, select the features that you want
to install.

Your choices are as follows:

CAD Standards Contains tools for reviewing design
files for compliance with your stan-
dards.

Database Contains database access tools.

Dictionaries Contains multi-language dictionaries.
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Drawing Encryption Allows you to use the Security Options
dialog box to protect a drawing with

a password.

Fonts Contains AutoCAD fonts and True
Type fonts.

Content Search Allows you to search AutoCAD Archi-

tecture for installed content.

Portable License Utility ~ Contains portable license manage-

ment tools.
Migrate Custom Set- Migrates custom settings and files
tings from a previous version of your prod-

uct to this version. See Migrate Cus-
tom Settings.

Reference Manager Allows users to view and edit the paths
of externally referenced files associated
with a drawing.

Samples Contains various feature sample files.

VBA Support Contains Microsoft Visual Basic for
Applications support files.

AutoCAD Profile Creates an AutoCAD profile and no
desktop shortcut

If, after making feature changes, you decide you want the original
selections, click the Restore Defaults button.

3 Enter the path on the client workstation where you want to install the
program, for example C:\Program Files\AutoCAD Architecture 2009, or
click the Browse button to specify the install location.

The Disk Space Requirements chart lets you review available drives and
disk space.

4 Click Next.
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Selecting Appropriate Content Packs

On the Configure Content Packs page, you can select Content Packs, which
are collections of locale- and discipline-specific profiles and content files, to
install with AutoCAD Architecture. You can opt to install an AutoCAD-only
profile and desktop shortcut. You can also specify a new location for the
Content Browser library file.

Content files include:
Templates

Content Browser catalogs
Layer standard files

Style drawings

Detail Component and Keynoting catalogs

Plotter and Plot Style configuration files

Desktop shortcuts for Content Packs launch the product with the Content
Pack profile. At least one Content Pack must be installed. Selecting multiple
Content Packs will increase disk space requirements and install time.

J fahum{ih[l Architecture 2009 [ |

Information Configure Content Packs ‘
A

2]

Content Pack Desktop Shortcut

. i o
What iz & Content Pack? AutoCAD Profile

* Can | add or remove Content Packs AuboCAD 2009 Mo
at a later date?

Architecture
* Howe do | create an SutaCaD

profile?

US Imperial es
1S Mekric Yes
[0 bacH P

[Itodify Content Browser Library file location
®What iz & Content Broweser Library
file?
Disk space requirements

Valu, .. Disk Size | Available | Required Total Required | Remaining ’\
s 93.1 GB 7358 GE 1.11 GB 1.11 GB 727 GB
F: 349 GE 274 GB 0 bytes 0 bytes 274 GB
[H 269 66 145 GE 0 bytes 0 bytes 145 GE I
I 269 66 145 GE 0 bytes 0 bytes 145GE | ¥
Configuration Progress: Page 3 of 5
i | Back
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The following table lists the available Content Packs, shortcut names, and
profile names for AutoCAD Architecture.

Content Shortcut Name Profile Name
Pack Name
AutoCAD Architecture

US Imperial AutoCAD Architecture 2009 (US Impe-  AutoCAD Architecture (US
rial) Imperial)

US Metric AutoCAD Architecture 2009 (US Met-  AutoCAD Architecture (US

ric) Metric)
DACH AutoCAD Architecture 2009 (D ACH)  AutoCAD Architecture (D A
CH)
Danish AutoCAD Architecture 2009 (Danish)  AutoCAD Architecture (DAN)
Finnish AutoCAD Architecture 2009 (Finnish)  AutoCAD Architecture (FIN)

Norwegian AutoCAD Architecture 2009 (Norwe-  AutoCAD Architecture (NOR)

gian)
Swedish AutoCAD Architecture 2009 (Swedish)  AutoCAD Architecture (SVE)
UK AutoCAD Architecture 2009 (UK) AutoCAD Architecture (UK)

Add an AutoCAD Profile and Desktop Shortcut

To add an AutoCAD 2009 profile, select AutoCAD 2009 from the Content
Packs list on the Configure Content Packs dialog. You can also install a desktop
shortcut for this selected profile by clicking Yes in the profiles’s Desktop
Shortcut column.

IMPORTANT You can only add an AutoCAD profile and desktop shortcut during
the initial installation of AutoCAD Architecture.
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Specify Content Browser Library File Location

The Content Browser Library file references Content Browser catalogs. The
default location for this file is My Documents\Autodesk\My Content Browser
Library\ACD-A 2009\ in Windows XP and Documents\Autodesk\My Content Browser
Library\ACD-A 2009\ in Vista. You can specify another location for this file.
When installing to a single machine, you can specify a filename or folder. If
you are creating a deployment, you must specify an existing file.

Specify Configurable Folders

The Configurable Folders page allows you to specify custom locations for
groups of content. For example, you may wish to share layer standards between
users, allowing standards to be updated from one location.

[ AJAutoCAD Architecture 2009 & |

Information Configurable Folders ‘
A

Group Mode Path s

* WWhat can Configurable Folders do Support

far me? Pp

Menus Default

* What iz contained in each group? Flotters Default
Flot Styles Default

* What are Modes?

Content

* What does the Append button do? AEC Styles and ... Default
Tool Catalogs Default
Templates Default -
1 mime Chmmd e FumFealke IL J

Append
Disk space requirements:
Valu, .. Disk Size | Available | Required Total Required | Remaining | |[# |
s 93.1 GB 7358 GE 1.11 GB 1.11 GB 727 GB
F: 349 GE 274 GB 0 bytes 0 bytes 274 GB
[H 269 66 145 GE 0 bytes 0 bytes 145 GE
I 269 66 145 GE 0 bytes 0 bytes 145GE | ¥
Configuration Progress: Page 4 of 5
( ) Back

Configurable Folder Groups

The following are content groups for Configurable Folders:

B Menus (menu files)
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B Plotters (plotter configuration files and default location for new plotter
configurations)

B Plot Styles (color- and style-based pen table settings)

B AEC Styles and DesignCenter Content (sample object styles AEC content
accessed from DesignCenter and tool palettes)

m Tool catalogs (Design and Documentation tools that refer to all stock object
styles and AEC design content)

B Templates (drawing templates, sample folder structures for Drawing
Management, and Space Evaluation templates)

B Layer Standards drawings (various global layer standards)
B Textures (texture file library)

B AEC Details (keynote and material database files used by AEC Details,
including support content)

Configurable Folder Modes

Specify one of three Configurable Folder modes for your content: Default,
Local, or Shared.

Default Content. Default content files are installed on your computer in the
default location in the Document and Settings folder in Windows XP and
ProgramData folder in Vista. When you uninstall the program, default content
files are also uninstalled.

Local Content. Local content files are installed on your computer in
non-standard locations. You can install a content group to a location other
than the default folder. When you uninstall the program, local content files
are also uninstalled.

Shared Content. Shared content files are installed where they can be shared
among multiple computers, enabling multiple users to access the same copy
of AutoCAD Architecture content. If you specify the same location for a
subsequent installation, you will be prompted to overwrite the existing shared
content files. When you uninstall the program, shared content files are not
uninstalled.

Creating a Deployment with Shared Content

If you create a deployment with shared content you will notice that the content
files are written to the shared locations when the deployment is created. You
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will also find that content for all Content Packs has been written to the shared
locations. This is done to ensure that content is present for workstations that
may, at a later date, elect to install additional Content Packs.

The Append Button

Click Append on the Configure Configurable Folders dialog to add a default
folder name to a content group’s path.

Define Search Paths and File Locations (optional)

On the Define Search Paths and File Locations page, you can modify the
default search paths and the location of some program files. You might want
to modify the default settings for the following reasons:

B If your CAD environment uses a file (such as a customization file or
plug-ins) other than the default file that's installed with the program, you
can point to that file now and avoid having to add it at each workstation.

B Some default file locations may have changed in this version of the
program. You can use this page if you have an earlier version of the
program, and you want to move the files to the same file location as your
earlier version of the program.

NOTE You can also modify the search paths and file locations for individual
workstations after you have installed the program. You do this by using the Options
dialog box. For more information, see Specify Search Paths and File Locations in
the User's Guide.

To use the default program settings for search paths and file locations

B While creating a deployment, on the Define Search Paths and File Locations
page, click Next.

To modify the default program settings for search paths and file
locations

1 While creating a deployment, on the Define Search Paths and File
Locations page, in the Define Search Paths, File Names, and File Locations
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list, click the plus sign (+) to the left of a search path or file location to
select and expand it.

Define Search Paths and File Locations

Define search paths, file names and file locations:

- {E, Suppart File Search Path i M
- E Customization Files

- g4 Custom Dictionary File
i (7] Alternate Font File

e Font Mapping File

e ﬁ Printer Support File Path
H

H

H

H

m

% Automatic Save File Location Mowe Down
% Color Book Locations
% Data Sources Location
ﬁ Template Settings

e OO e OO proy OO s OO s N s OO s OO o O o |

2 Select an item in the list and do any of the following:

To browse to a file location, click Browse.

To add a new entry to the currently selected search path or file
location, click Add.

To remove an entry from the currently selected search path or file
location, click Remove.

To move a selection up or down in the list, click Move Up or Move
Down.

NOTE The availability of these buttons depends on the item that you selected
in the previous step.

3 When you finish specifying search paths or file locations, click Next.

Install Additional Files (optional)

On the Install Additional Files page, when you click Browse, you can specify
additional files to include with a deployment. By default, these files are
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installed in the program's installation directory on client workstations when
the deployment is run. You can install files to multiple directories if desired.

You can perform the following operations:

Specify additional files (such as drawing files, AutoLISP® routines, or script
files) to include with your deployment.

Install different types of files to different workstation directories.

Add subfolders under the installation folder (for example, a folder called
LSP to contain custom AutoLISP routines).

Add files to the same location as program files (for example, add sample
drawings for a project).

Add files to the root of the installation directory.

NOTE It is recommended that you install these files to a location within the
program's directory structure. You cannot install files with the same file name as
an installed program file. For example, you cannot add a file named acad.cui.
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To install additional files

1 While creating a deployment, on the Install Additional Files page, set the
location where file will get installed.

Install Additional Files

To include additional files into this deployment, first set the location of where the
file(s) will be installed, then dick Browse to select the file(s) to be induded.

Spedfy where to place the files:
[=E0 ] <Installation Directory> - Browse...
- |, CER
- 4 Drv
----- . Express

..... | Fonts Add Folder

----- | GAC430
----- | GAC431 Add Drive
----- | GAC432
----- | GAC433 Remove
----- | GAC434
----- | GAC435
| Help
| Sample
. Support
, Tutarial -

m

im0 o O s O e

2 Do any of the following:

B Click Browse to open the Add Files dialog box, where you can select
files to add to the installation directory.

B Click Add Folder to create a new folder in the installation directory.

B Click Add Drive to add a drive name to the file location structure. The
drive name must be a valid drive letter and colon, for example C: or
F:. Uniform Naming Convention (UNC) paths are not supported.

B Click Remove to delete a file, folder, or drive from the installation
directory.

3 Click Next.
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Specify User Preferences (optional)

On the Specify User Preferences page, you can specify whether installations
based on this deployment can proceed if Microsoft Internet Explorer is not
installed, specify a default profile name, choose to display the product shortcut
icon on the desktop, or create a custom desktop shortcut.

To specify user preferences settings

1

While creating a deployment, on the Specify User Preferences page, clear
the check box for the Internet Explorer option if you do not require
Microsoft Internet Explorer to be installed before AutoCAD Architecture
is installed.

Specify User Preferences
Internet Explorer is required for installations
Set DWFx as default Publish Format
Set the AutoCAD profile name:

AutoCAD

In the Default Profile Name box, specify a default profile name that will
be current for all users who run the deployment and the default text
editor.

If you want to create a custom desktop shortcut, specify a shortcut name
and any parameters, such as switches that will call profiles, startup scripts,
and so on.

Create custom desktop shortouts:

Shortcut name Shortcut parameters
<type shortcut name> <type parameter>

4 C(Click Next.
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Include Service Packs (optional)

During the deployment process, you can choose to include service packs that
have been posted for your product. The installer automatically checks
autodesk.com for available updates. If no updates are available, the link is
disabled. If updates are available, click on the link and download the patch
from autodesk.com to a location specific to your deployment. You can append
or chain the patch. For more information, see To include a service pack with
the deployment on page 54.

Include Service Packs

If service packs are avaiable for your product, you may download them from Autodesk and
indude them with the product's deployment.

Updates are avallable

To indude service packs, you must extract and save the M5P file, Then, you must browse to
locate the MSP fille(s) and add them to the list below,

Service packs induded in this deployment:

Browse...

|2
]
[=]
I

Service pack options:

@ Append the service packs onto the deployment,
_ Merge the service packs into the administrative image MSI file,

When you include a service pack, you can also specify how it will be handled.
You can choose from the following;

B Append the Service Packs onto the Deployment. When you append a
service pack, the service pack is applied to the current deployment only.
Multiple service packs may be appended to a deployment. The service pack
file is included in the deployment and the service pack is applied after the
product is deployed.

B Merge the Service Packs into the Administrative Image MSI File. When
you merge a service pack, the service pack is merged into the administrative
image. Once merged, a service pack may not be removed from the
administrative image. Multiple service packs may be included in a single
administrative image.
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To extract an MSP file from a service pack

1 Download the service pack from the Autodesk product support site.
2 Review the service pack Readme file for information about patch usage.
3 Open a Windows command prompt and enter the patch file name

followed by the /e switch and a target file name, such as:

ProductSPl.exe /e ./ProductSPl.msp

where <ProductSP1.exe> is the name of the downloaded patch and
<ProductSP1.msp> is the name of the extracted file. Using *./’ in front of
the extraction file name places the extracted file in the same folder as
the original executable.

NOTE To find out if a service pack is available, visit the Autodesk Product
Support page at http://support.autodesk.com/.

To include a service pack with the deployment

To include a service pack with a deployment, an MSP file must be extracted
from the downloaded service pack executable.

1 On the Include Service Packs page, click the Browse button.

2 Inthe Open dialog box, locate the service pack you want to include with
the deployment.

3 Select the MSP file and click Open.

4 Specify whether you want to append the service pack on to the
deployment or merge the service pack into the administrative image.

5 Click Next.

Configure InfoCenter Communication Center
(optional)

The Communications Center is accessed through InfoCenter. Products are
updated with Live Update, which downloads patches to your product using
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Communication Center. Beyond Live Update, other information channels
and feeds can be displayed by the Communication Center.

Configure InfoCenter Communication Center

Communication Center Panel
Enable live updates
[Rer_eive Live Updates from Autodesk -

[=s}
I=]
%]
m

Enable Information Channels

Enable CAD Manager Channel

Feed location:

Viserveri\feedimyfeed. xml Browse...

Display name:

CAD Manager Channel

Enable RSS feeds
[¥] Allow user to add RSS feeds

The Communication Center settings you can make include

Enable Live Updates. Users can use Live Update to check for updates when
a web connection is established. If a product patch is available, notification
of its availability is received on the program's status bar, and the patch can
be either downloaded directly from an Autodesk server or modified first
before being copied to users' workstations. If you don't want users to receive
updates or announcements, you can turn off Live Update.

NOTE You can also turn Live Update options on or off in the CAD Manager
Control utility. See How to Install and Start the CAD Manager Control Utility

Enable Information Channels. When active, information channels notify
users with various pieces of information such as subscription
announcements and product support information.

Enable CAD Manager Channel. Controls the display of the CAD Manager
Channels in InfoCenter. Aside from being able to toggle CAD Manager
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Channels, you can also define the CAD Manager feed location and set the
display name for the CAD Manager Channel.

Enable RSS Feeds. Users can subscribe to any number of RSS feeds. Each
feed is contained within a discrete InfoCenter category. Additionally, you
can specify whether users can add RSS feeds.

To configure Communication Center

1
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When creating a deployment, on the Configure InfoCenter
Communication Center page, make the following Live Update settings:

B Enable Live Updates. Users can receive product updates or support
announcements from Autodesk servers.

B Receive Live Updates from Autodesk. Users can receive product updates
and support announcements from Autodesk servers with Live Update.

B Receive Live Updates from Internal Server. You can maintain a patch
list on a local server. If you select this option, the Local Patch List
Location box is available. Use the Browse button to locate the path
to a server location where you want a patch list. More information
about how to use a local patch list is available by installing Autodesk
CAD Manager Tools 4.0, running the CAD Manager Control utility,
and then clicking Help in the CAD Manager Control utility window.

NOTE You can name a file to use for patch information. By naming a file
and using an .npl extension now, you are creating a placeholder file, not
creating the file itself. In the location that you specify in the Local Patch
List Location box, you must create a text file with the same name you
specify here.

Specify whether Information channels should be enabled.

Specify whether CAD Manager channels should be enabled. When active,
you can make the following settings:

B Feed Location. Defines the location of the CAD Manager channel RSS
feed. RSS feeds are in XML format.

B Display Name. Sets the display name of the CAD Manager channel.

Specify whether RSS Feeds are enabled and if users are allowed to add
feeds.

Click Next.
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Allow Users to Access Online Resources (optional)

On the Configure Access to Online Resources pages, you can specify whether
users can access online resources such as receiving live updates from Autodesk,
enabling information or CAD Manger channels, or subscribing to RSS feeds.

You can also allow access to the DesignCenter and Subscription Center, specify
Customer Error Reporting and InfoCenter settings.

Configure Access to Online Resources

Specify the ability o access online tools:

Enable DesigniZenter(DC) Online

Allow access bo Subscription Cenker From within the Autodesk product
(recommended)

Specify the Cuskomer Error Feporting (CER) settings:

Allows users ko receive nokifications of resolution

|:| Include computer name in errar reporks

Specify the Customer Invalvement Program sektings:

Allo users bo choose to participate in the Customer Involvement
Programi(tecommended)

DesignCenter and Subscription Center

The DC Online tab in DesignCenter® provides access to predrawn content
such as blocks, symbol libraries, manufacturers' content, and online catalogs.
This content can be used in common design applications to assist users in
creating drawings. If you turn off DC Online, the DC Online tab is removed
from all installations that are based on this deployment. The Enable DC Online
option is active by default.

Subscription Center provides Autodesk subscription members access to
resources such as e-Learning (self-paced, interactive lessons) and web support

Allow Users to Access Online Resources (optional) | 57



(where customers can submit technical questions online to Autodesk support
staff).

Specify the ability to access online tools:

/| Enable DesignCenter{DC) Online

Allow access to Subscription Center from within the Autodesk product
{recommended)

You can determine whether users who are entitled to subscription resources
can access them by using Help and clicking a Subscription resource. Users
who do not have such access can still learn about subscription resources by
using the same option on the Help menu.

NOTE You can also enable or disable DesignCenter Online and Subscription Center
access from the CAD Manager Control utility.

Customer Error Reporting (CER)

If AutoCAD Architecture closes unexpectedly, users have the opportunity to
send an error report directly to Autodesk, which helps Autodesk to determine
and resolve the error. You can determine whether users can also receive
notification from Autodesk when their reported errors are resolved.

Specify the Customer Error Reporting (CER) settings:

| Allow users to receive notifications of resolution

Indude computer name in error reports

NOTE You can also turn Customer Error Reporting notification on or off in the
CAD Manager Control utility.

Configure InfoCenter Search Settings

The Search Results tab of InfoCenter can be configured to display content
from various sources, such as the product Help system, CAD Manager
Channels, or the Internet.

Specify the InfoCenter search settings:

| Allow user to customize search locations

You can specify whether users who install from the deployment can customize
access to their InfoCenter search locations.
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To configure access to online resources

1 While creating a deployment, on the Configure Access to Online Resources
page, do one of the following to configure DesignCenter Online:

B To disable DesignCenter Online, make sure that the check box next
to Enable DC Online is cleared.

B To enable DesignCenter Online, select the check box next to Enable
DC Online.

2 To allow access to the Subscription Center, select or clear the check box
next to Allow Access to Subscription Center from Within the Autodesk
Product (Recommended). This option is enabled by default.

3 If you want to receive notification of problem resolutions, do the
following:

B Select the check box next to Allow Users to Receive Notification of
Resolution so that users are made aware of resolutions to issues and
can download applicable updates provided by Autodesk. This option
is enabled by default.

NOTE Users must have administrative permissions to install an update
provided by Autodesk.

B Select the check box next to Include Computer Name to include the
user’s computer name in error reports. The computer name is included
in notifications to the user and in reports available to subscription
administrators. This option is disabled by default.

4 Lastly, specify whether users have the option to customize their
InfoCenter search locations. This option is enabled by default.

5 Click Configuration Complete.

Final Review and Complete Setup

To complete your deployment setup, confirm the settings you selected.
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To confirm and complete the setup of a network deployment

1 After making all your deployment settings, on the Review - Configure -
Create Deployments page, scroll the list of current settings and verify
your installation selections.

Review - Configure - Create Deployments
The basic information required to install the products has been provided by vou and is shawn in
the box belovs, The remaining configurations are currently set bo the default values; also

showin below, IF yvou would like to make confiquration changes, select the appropriate product
from the drop down list and click the Configure button,

Select a product to configure:

<My Product = [t Configure

Current settings:

License type:
License zerver model:
Server namels);
Install type:
Exzpress Tools
Material Library
Install location:
Search pathsfile locations:
Additional files included:
Default text editar;
Silent installation:

Internet Explarer is required:

Default profile:

Create a shortcut:
Custom shortouts:
Service packs applied:

Prink

Metwark License

Single Server License
hilyMetworkServer

Typical

Yes

Mo

CHProgram FilesWWyProgramt

Motepad

Ves

Ves

==lnnamed Profile==
Ves

2 If you want to change any selections you made for the deployment, click
the Configure button.

3 If you want a hardcopy of the installation information displayed on this
page, click the Print button.

4 If you are ready to complete the deployment, click Create Deployment.

5 On the Deployment Complete page, click Finish.
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To confirm and complete the setup of a multi-seat stand-alone

deployment

1 After making all your deployment settings, on the Review - Configure -
Create Deployments page, scroll the list of current settings and verify

your installation selections.

Review - Configure - Create Deployments

The basic information required to install the products has been provided by vou and is showvn in
the biox below, The remaining configurations are currently set ko the default values; also
shiowwn below, IF wou would like to make configuration changes, select the appropriate product
from the drop down liskt and click the Configure button,

Select a product ko configure:

<MyProduck=

Current setkings:

License type:
License server model:
Server namels):
Install type:
Express Tools
Idaterial Library
Inztall location:
Search pathaffile locations:
Additional files included:
Default text editar:
Silenit installstion:
Irternet Explorer is recuired:
Default profile:
Creste a shortout:
Custom shortouts:
Service packs applied:

Prink

hd Configure

Metweark License

Single Server License
hilyMetworkServer

Typical

Ves

Mo

CHProgram FileshyProgramt

Motepad

Yes

Yes

==lnnamed Profiles:=
Yes

2 If you want to change any selections you made for the deployment, click

the Configure button.

3 If you want a hardcopy of the installation information displayed on this

page, click the Print button.

4 If you are ready to complete the deployment, click Create Deployment.
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5 On the Deployment Complete page, click Register Products Online.

Register all products. Use the link below to register the products online. If you do not have
Internet access you may register the products during the activation process.

Reqister products onling

Click Finish to exit.

Registration at this stage ensures that consistent data is being used to
streamline product activation. When a user installs from this deployment
and runs the product, registration data is automatically referenced and
the product gets activated. See Register the Product on page 62.

6 Click Finish.

You have created an Autodesk product deployment with precise options that
are specific to your group of users. You can now inform those using this
deployment where the administrative image is located so that they can install
the program.

Register the Product

It is very important that the registration data (for example, your company
name and contact information) you supply when registering and activating
your products is consistent across all Autodesk products that you install. If
you enter this data incorrectly or inconsistently, you can run into activation
problems.

The way products are registered depends upon the type of license you selected
while creating the deployment. In order to receive an activation code, your
product must be registered.

To register a network licensed deployment

1 On the Start menu (Windows), click All Programs (or Programs) »
Autodesk » Network License Manager » AutoCAD Architecture 2009
Network License Activation Utility.

2 On the Obtain a Network License page, review how this utility works and
the requirements for using it, and then click Next.
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3 Follow the on-screen instructions to complete the registration and
activation.

To register a multi-seat stand-alone licensed deployment
1 On the Deployment Complete page, click Register Products Online.

Register all products. Use the link below to register the products online. If you do not have
Internet access you may register the products during the activation process.

Reqgister products onling

Click Finigh to exit.
The Register Today page is displayed. You complete Register Today at
this point so that all users have the same default registration information.

2 In the Register Today wizard, follow the on-screen instructions to
complete the registration.

NOTE This process only registers the product. If users are connected to the Internet,
activation occurs automatically when the product is started.

Modify a Deployment (optional)

After a deployment is created, it may be necessary to modify the deployment
for some client workstations. You can apply a patch or select various custom
files that are not part of the base administrative image. You can also perform
modifications such as changing the installation directory from drive C to drive
D.

To modify a deployment

1 Open the shared network folder where you originally chose to place your
product deployment.

2 In the Tools folder, double-click the Create & Modify a Deployment
shortcut.

This re-opens the Installation wizard.

3 Click through the deployment pages and make the necessary changes.
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4 After all the modifications have been made, click Create Deployment.

Point Users to the Administrative Image

When you have completed the deployment process, you are ready to have
users install the newly created or modified deployment. You need to notify
your users of the shortcut that was created in the administrative image. The
shortcut is the same name that you chose in Create a Deployment on page
32.

To point users to the administrative image

B The simplest method of notifying users how to install the deployment is
to email them with instructions about using the shortcut. At a minimum,
the instructions need to include the location of the deployment and
instructions about double-clicking the shortcut to the deployment.

NOTE For more advanced ways of using the shortcut and installing the
deployment, see Use Scripts to Deploy the Program on page 67, Use Group Policies
to Install a Deployment on page 79, or Distribute the Product Using Imaging
Software.

Uninstall the Program

When you uninstall AutoCAD Architecture 2009, all components are removed
in the process. This means that even if you have previously added or removed
components, or if you have reinstalled or repaired the program, uninstalling
removes all program installation files from your system.

NOTE If you plan to modify an administrative image at a later date (for example,
by adding a patch to it), do not remove that image.

To uninstall the program

1 In the Windows Control Panel, click Add or Remove Programs.

2 Inthe Add/Remove Programs window, select AutoCAD Architecture 2009,
and then click Change/Remove.
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3 When the Installation wizard opens, choose Uninstall AutoCAD
Architecture 2009.

4 On the Uninstall AutoCAD Architecture 2009 page, click Next to remove
AutoCAD Architecture from the system.

5 When informed that the product has been successfully uninstalled, click
Finish.

NOTE Autodesk programs that you use with the program (such as Autodesk
Design Review 2009) are not removed automatically when you uninstall AutoCAD
Architecture. You must uninstall them separately using Add or Remove Programs.

Uninstall the Program | 65



66



Use Scripts to Deploy the
Program

A script executes a command or a set of commands. Scripts are similar to batch files but are
more flexible. Installation scripts are most useful for stand-alone installation of programs on
computers that are connected to a network. Scripts are also useful for installing service packs,
extensions, and object enablers on a network.

In order for AutoCAD Architecture to run properly, the following software and prerequisites
must be installed and met on the computer where the program is being installed:

B Microsoft Internet Explorer version 6.0, SP1 or later (You can download Microsoft Internet
Explorer from the Microsoft website by visiting www.microsoft.com)

B Microsoft Scripting Engine
The sample scripts in this section are based on Microsoft Scripting Engine 5.6, which works
with both VBScripts and JavaScript. If you don't have the scripting engine installed, you
can download it for free from the Microsoft website at www.msdn.microsoft.com/scripting.
Sample scripts and Help files are also available there for download.

B Administrative permissions

Create Scripts That Install Programs

You create a script by using a text editor such as NotePad and then saving it in
ASCII format in a file with the file extension .vbs. The script consists of one or
more commands, as well as command switches that specify options, and flags
that modify the options. An installation script also contains path names.

An installation script points to the location of the product's setup.exe file. You
must point to the setup.exe file on your product DVD. For example:
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AutoCAD Architecture 2009 CDROM1 \setup.exe

A Sample Installation Script

The sample script in this section installs the program in a typical configuration.
To make it easy to copy this sample script and substitute your own information,
the same names are used throughout for variable items. The log file name is
based on the product being installed. You can either use the log file name in
the script or change it to something else.

Serial number prefix: 123

Serial number: 12345678

First name: Your First Name

Last name: Your Last Name
Organization: Your Company Name

A sample script for a silent installation of this program uses the syntax shown
in this section.
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Scripted installation for AutoCAD Architecture 2009

' Scripted installation for AutoCAD Architecture 2009

option explicit

v

' Create variables

dim x64bit

dim shell

dim productType

dim featuresToInstall
dim strADSKFirstName

dim strADSKLastName

dim strADSKOrganization
dim strADSKSercirity

dim strADSKSeriallIsvalid
dim strADSKAccept

dim strADSKEula

dim strADSKRelInstall

dim strADSKRemove

dim strADSKSNPrefix

dim strADSKSNNumber

dim strInstallLevel

dim strACADStandaloneNetworkType
dim strADSKLicenseServerType
dim strADSKLicenseType
dim strADSKServerFmtPath
dim strADSKServerPath
dim strADSKServerHostID
dim strADSKPath

dim strSourcePath

dim strAdditionalStuff

Script initialization
Set shell = CreateObject ("WScript.Shell")

productType = "acad"
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' Name and Organization information

strADSKFirstName = "Your First Name"
strADSKLastName = "Your Last Name"
strADSKOrganization = "Your Organization Name"

T
' Serial Number information

strADSKSNPrefix = "123"
strADSKSNNumber = "45678901"
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Source to install from

strSourcePath = "D:\"

Destination t

o install to

(e.g. D:

is assumed to be Install Media)

strADSKPath = Shell.ExpandEnvironmentStrings ("$ProgramFiles%") +

"\AutoCAD Arch

Features to i

itecture 2009"

nstall

ACS - AutoCAD Architecture Samples

CADStandards

Database - Database

- CAD Standards
ContentSearch - Content Search
(DBCONNECT)

DCS - DesignCenter Samples

DigSig - Digi
Dictionaries

tal Signatures

- Dictionaries

DrawingEncryption - Drawing Encryption

Fonts - Fonts

Materials - Materials Library

Migrate - Migrate Custom Settings

NFW - New Features Workshop

PLM - Portable License Utility

RefMan - Reference Manager

System Files

fault- in this

TM - Texture
VBA - Visual
VLS - Visual
VLT - Visual

- Required system files (must be installed by de

script)
Maps

Basic for Applications

LISP Samples
LISP Tutorials

Sample is below - Note the leading comma

featuresToInstall = ",DigSig, TM,CADStandards,Con

tentSearch, Database,Dictionaries,DrawingEncryption, Fonts, NFW,Mi
grate,RefMan, Samples,ACS,DCS, VBA,Materials, PLM, VLS, VLT"
strInstallLevel=3 ' 5 installs everything - 3 installs typical -

0 uses featuresToInstall

A Sample Installation Script | 71



'Yt Uncomment the relevant version of your installation - De
fault is Standalone

' For Standalone

RunStandaloneInstall ()

T

' For Single Network License Server
'RunSinglelicenseServerInstall ()

Al

' For Redundant Network License Servers
'RunRedundantLicenseServerInstall ()

Al

' For Distributed Network License Servers
'RunDistributedLicenseServerInstall ()

L}

' End of Script

Wscript.quit ()

Function RunStandaloneInstall
shell.run DefaultCommand(),2,1

end function

v

Function RunSinglelLicenseServerInstall

' Update with the correct information for the license server
strACADStandaloneNetworkType = "3"

strADSKLicenseServerType = "Single Server License"
strADSKLicenseType = "Network License"

strADSKServerPath = "myFlexServer"

' HOSTID or MAC address

strADSKServerHOSTID = "000000000000"

'

' Consolidate the two values

strADSKServerPath = strADSKServerPath & " " & strADSKServerHOSTID
shell.run MakeCommand(),2,1

end function

v
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Function RunRedundantLicenseServerInstall
' Update with the correct information for the license servers
strACADStandaloneNetworkType = "3"

strADSKLicenseServerType = "Redundant Server License"
strADSKLicenseType = "Network License"

' Format is SERVERNAMEl MACADDR1 PORT1; SERVERNAME2 MACADDR2 PORT2;

SERVERNAME3 MACADDR3 PORT3; - Only 3 permitted for redundant
servers
strADSKServerPath = " myflexl 000000000000 27005; myflex2

000000000000 27005; myflex3 000000000000 27005;"
shell.run MakeCommand(),2,1

end function

Function RunDistributedLicenseServerInstall
' Update with the correct information for the license servers
strACADStandaloneNetworkType = "3"

strADSKLicenseServerType = "Distributed Server License"
strADSKLicenseType = "Network License"

v

' Format is Q@SERVERNAMEL; SERVERNAME2; SERVERNAME3;
strADSKServerPath = "@ myFlexServer;@ myFlexServer2;@ myFlexServ
er3;"

'

shell.run MakeCommand() & "ACAD LICENSESERVER _DISTRIBUTED=1",2,1
end function
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Function Def

dim retStrin

aultCommand
g

' /q for silent install ' /c [key] override parameters for the key

retString = """" & strSourcePath & "D:\setup.exe" & """" & " /t

/q /c " & productType & ": "

retString = retString & "INSTALLDIR=" & """" & strADSKPath & """"
g "o

retString = retString & "ACADSERIALPREFIX=" & strADSKSNPrefix & "

retString = retString & "ACADSERIALNUMBER=" & strADSKSNNumber & "

retString = retString & "ACADFIRSTNAME=" & """" & strADSKFirstName
& "o Mo "

retString = retString & "ACADLASTNAME=" & """" & strADSKLastName
& "o ™o

retString = retString & "ACADORGANIZATION=" & """" & strADSKOrga

nization & """" & " "

if strInstalllLevel = 0 then

retString = retString & "ADDLOCAL=" & """" & "System Files" &

featuresToInstall & """" & " "

else

retString = retString & "InstallLevel=" & strInstalllLevel & " "

DefaultCommand = retString & " "

end if

DefaultCommand = retString & " "

end function

Function MakeCommand

dim retString

retString = DefaultCommand() & " "

retString = retString & "ACADSTANDALONENETWORKTYPE=" & """" §&
strACADStandaloneNetworkType & """" & " "

retString = retString & "ACADLICENSESERVERTYPE=" & """" & strAD
SKLicenseServerType & """" & " "

retString = retString & "ACADLICENSETYPE=" & """" & strADSKLicense
Type & """" & " "

retString = retString & "ACADSERVERPATH=" & """" & strADSKServer
Path & """" & " "

MakeCommand = retString

end function
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Use Switches and Flags in Scripts

The following table lists all of the switches and flags that are relevant to
installation.

NOTE You must set the installation switch to INSTALLDIR=. If this is not done,
programs that run outside AutoCAD Architecture (such as the Portable License
utility) are not installed.

Switches in Installation Scripts

Switch Description
INSTALLDIR= Specifies the location to install the product.
ACADSERIALPREFIX= Specifies the numbers that precede the hyphen

in the serial number.

ACADSERIALNUMBER= Specifies the serial number.

INSTALLLEVEL= Specifies the type of installation: 3=Typical
ACADFIRSTNAME= Specifies the first name personalization.
ACADLASTNAME= Specifies the last name personalization.
ACADORGANIZATION= Specifies the company name.

ADDLOCAL= Used for customized installations where you des-

ignate specific features to install.
See Scripts for Custom Installations.

User Interface Flags

Flag Description

q Designates that the installation is performed in silent mode.
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Scripts for Custom Installation

To create a script for custom installation, use the sytax aApbLocar="...".

The following example shows how component flags are used in the
DefaultCommand section of a script.

Function DefaultCommand
dim retString
' /q for silent install ' /c [key] override parameters for the
key
retString = strSourcePath & "\setup.exe /t /g /c " & productType
& "o "
retString = retString & "INSTALLDIR=" & """" & strADSKPath &

wewn oowow

retString = retString & "ACADSERIALPREFIX=" & strADSKSNPrefix &

retString = retString & "ACADSERIALNUMBER=" & strADSKSNNumber &

retString = retString & "ACADFIRSTNAME=" & """" & strADSKFirst

Name § ""ww g wow

retString = retString & "ACADLASTNAME=" & """" & strADSKLastName
g "mmm g owom

retString = retString & "ACADORGANIZATION=" & """" & strADSKOr

ganization & "nnnooowow

retString = retString & "InstalllLevel=" & strInstalllevel & " "

' retString = retString & "ADSK LAUNCH MODE=Standalone" & " "
if strInstalllLevel = 3 then

retString = retString & "ADDLOCAL=" & """" & "Sys
tem Files,ACS, Impression,NFW" & featuresTolInstall & """" & "
"
end 1if

retString = retString & strAdditionalStuff ' Specifically for
Impression Toolbar

DefaultCommand = retString & " "

The table below lists all the component flags you can use.

Component Flags

Flag Component

ACS AutoCAD Architecture Samples
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Component Flags

Flag Component
CADStandards CAD Standards

Database Database (DBCONNECT)
DCS DesignCenter Samples
DigSig Digital Signatures
Dictionaries Dictionaries

DrawingEncryption

Drawing Encryption

Fonts Fonts

Migrate Migrate Custom Settings
NFW New Features Workshop
PLM Portable License Utility
RefMan Reference Manager
Samples Sample files
System_Files Required system files
™ Texture Maps

Tutorials Tutorials

VBA Visual Basic

VLS Visual LISP Samples
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Component Flags

Flag Component

VLT Visual LISP Tutorials

Run Scripts

After creating a script, you move it to a server or use a mapped drive letter or
a UNC (universal naming convention) path. If you place it on a server for
users to run, create a share on the server, and then add users to the share with
the rights they need. Because all that users need to do is run the script, provide
read-only access to the share directory.

Next (on the same server or on a different server), create a directory for each
product you want to install. Choose a location for this directory that won't
be changed so that you can point to the MSI files in your scripts. Copy the
product CD(s) to that directory. You may also want to create directories for
service packs, extensions, and your own customization tools.

You can use any of the following methods to run an installation script:

B Run the script manually at each individual workstation. To run the
installation, paste the script into the Run dialog box or run it from the
Windows command prompt.

B Send an email with the UNC path to each user who should run the script.
To run the script, the user follows your instructions.

B Email the script to each user with instructions for use.

B Set up the script so that it runs on login.
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Use Group Policies to
Install a Deployment

With group policies, you can advertise this program by assigning the deployment to computers.

In order for AutoCAD Architecture to run properly, the following software must be installed
on the computer where the program is being installed:

Microsoft .NET 3.0 (available on the product DVD)

Microsoft Internet Explorer version 6.0, SP1 or later (You can download Microsoft Internet
Explorer from the Microsoft website by visiting www.microsoft.com).

Microsoft Installer Package (MSI) 3.1

Microsoft Windows Media Format 9.5 (prerequisite for 64-bit)
Macromedia Flash Player 9.0 (not installed by default)
Autodesk Design Review 2009 (not installed by default)

VC runtimes for x86 and x64 for 64-bit deployments

MSXML 6 and DirectX 9.0c

Introduction

With group policy objects, this program can be advertised to any Windows XP
or Windows Vista computer that is part of a Windows 2003 Server Active
Directory environment.
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Assign a Deployment Using Group Policies

Assign a deployment that was created during the deployment process by the
Installation wizard to a computer. Assigning a deployment to a computer
installs the program the next time the computer is restarted.

A deployment that is assigned to a computer can be used by any user of that
computer. Generally, you should assign the program to a computer if the
computer is used by a large number of users.

NOTE Autodesk products are designed to be installed on a computer so that any
user who logs on to the computer can run the software. If you attempt to assign
this program for a specific user rather than a computer, you may encounter
problems when a second specified user tries to install or uninstall a copy of the
program.

Advantages and Disadvantages of Using Group
Policies

The following table outlines the advantages and disadvantages of using group
policies.

Advantages and disadvantages of group policies

Advantage Disadvantage

B Works well with the deployment B Cannot pass command-line parameters to
functionality of the Installation MSI executable. The solution is to use
wizard. scripts.

B Easy to add custom files through B Cannot customize application settings
the deployment functionality of other than what is set while creating a
the Installation wizard. deployment with the Installation wizard.

B Deployed to workstation.

B Simple to implement.
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Distribute a Deployment Through Group
Policies

There are three main steps to distributing this program through group policies.

1 Create an application distribution share point. The application
distribution share point is created using the Deployment wizard. Follow
the steps outlined in Use the Installation Wizard to Set Up a Deployment
on page 31 to create a deployment.

2 Assign the program to a computer.

3 Verify the installation. Make sure that the program has been correctly
installed.

Assign a Deployment to Computers

When the program is assigned to a computer, it is available to all users of the
computer. The following procedures must be run from the server that has
access to the Windows 2003 Server Active Directory for assigning this program
to computers.

To assign a deployment to a computer

1 On the Start menu, click Programs (Windows XP) or All Programs
(Windows Vista) » Administrative Tools » Active Directory Users and
Computers.

2 In the Active Directory Users and Computers window, right-click the
organizational unit where you want to create the group policy object.
Then click Properties.

The Properties dialog box for the organizational unit you selected is
displayed.

NOTE In order for the group policy object to take effect, the computer objects
must be located in the organizational unit you have selected.

3 In the Properties dialog box, on the Group Policy tab, click New. Enter
a name for the group policy object. For example, enter AutoCAD
Architecture Computer Assigned Installation.
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11

12

13

14

The group policy is created and is added to the Group Policy Object Links
list.

In the Group Policy Object Links list, right-click the policy you just
created, and then click Edit.

In the Group Policy Object Editor window, under Computer
Configuration, click the plus sign (+) next to the Software Settings folder
to expand it.

Under Software Settings, right-click Software Installation, and then click
Properties.

In the Software Installation Properties dialog box, on the General tab,
click Browse.

In the Browse for Folder dialog box, locate the application distribution
share point created in the Deployment wizard, and select the Adminlmage
folder. Then click OK.

The Software Installation Properties dialog box displays (in UNC format)
the default package location, the server name, the shared folder that you
selected, and Adminlmage. For example:
\\server123\Deployment\Adminimage\x86 or x64 depending on the process
type

On the General tab, under New Packages, click Advanced to specify a

method to be used when a new package is created. This method also
allows the transform file created by the Deployment wizard to be selected.

Click OK to close the Software Installation Properties dialog box.

In the Group Policy Object Editor dialog box, under Software Settings,
right-click Software Installation, and click New » Package.

In the Open dialog box, make sure the Windows Installer Packages file
(aca.msi) is selected, and click Open. This default selection is the
application distribution share point that you set earlier.

If you created the administrative image in a location different from the
application distribution share point, find the administrative image
location, and click aca.msi.

In the <product name> Properties dialog box, click the Deployment tab.
Under Deployment Type, verify that Assigned is selected.

On the Modifications tab, click Add.
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15

16

17

18

In the Open dialog box, click the transform package file (.mst) created
by the Deployment wizard, and then click Open.

If you created the administrative image in a location different from the
application distribution share point, find the administrative image
location and select the transform package file (.mst).

In the <product name> Properties dialog box, on the Modifications tab,
the transform package you selected is added to the Modifications list.
Click OK.

NOTE You must select the transform package file created by the Deployment
wizard when you created the group policy object. You cannot add or remove
transform package files after the group policy object has been created. If you
fail to select a transform package file, the program cannot be installed on the
client computer.

In the Group Policy Object Editor window, under Computer
Configuration, click Software Installation. The newly created program
package is displayed in the right pane.

Close the Group Policy Object Editor window and any other open Active
Directory windows.

This program is assigned to all computers that are members of the
organizational unit for which the group policy object has been created. The
next time a computer in the organizational unit is restarted, the program will
be installed and will be available for all users of the computer. See Verify the
Installation of a Deployment on page 83 to validate that the group policy has
been created correctly.

Verify the Installation of a Deployment

As a computer is restarted, the operating system displays messages about group
policy, generally just before or after the Windows Login dialog box is displayed.
These messages include the following:

Windows starting up
Applying computer settings
Installing managed software <application>

Applying software installation settings
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B Loading your personal settings

B Applying your personal settings

From a Windows XP or Windows Vista workstation, users log in under the
organizational unit or computer for which the group policy has been created.

NOTE If problems arise, an entry is logged in the system's Event Viewer under
Applications.

Verify That the Program Is Assigned to a Computer

To verify that this program has been correctly assigned to a computer, restart
a computer that is in the organizational unit for which the group policy was
created. The program is installed before the login prompt is displayed. After
logging in, double-click the program icon on the desktop. A second-time
installation begins. At the completion of the installation, the program starts.
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Use Microsoft Systems
Management Server to
Install a Deployment

This appendix provides details for deploying Autodesk software using Microsoft Systems
Management Server (SMS). The benefits of using SMS to deploy software include software
distribution to target computers that are dynamically evaluated based on a set of
administrator-defined rules, and hardware and software that is inventoried to verify that
target computers meet setup requirements.

Introduction

To deploy Autodesk® software, you must have SMS 3.0 with Service Pack 1 or
later. You should also be familiar with the SMS 3.0 software distribution process.
You can find more information about this topic in the following resources:

Microsoft® Systems Management Server Administrator's Guide
Microsoft Systems Management Server 2.0 Administrator Help

Microsoft Systems Management Server 2003 Administrator’s Companion

Microsoft Systems Management Server Resource Guide
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Tasks for Deploying Autodesk Software with

SMS

To deploy Autodesk software with SMS, you must complete the following
tasks:

1

AN »n A W N

Create a collection for distributing Autodesk software.
Set up a source directory using the Deployment wizard.
Create the SMS software installation package.

Create an SMS program.

Create an advertisement.

Install the Autodesk software on the client computer.

Create a Collection for Distributing Autodesk

Software

A collection is a set of administrator-defined rules that determine which
computers Autodesk software can be installed on. You can use SMS to create
and maintain collections. Collections gather resources into logical, manageable
groups in ways that help you manage your SMS site. Collections can reflect
the structure and organization of your network by putting resources in groups
such as users, clients, and routers. SMS uses collections as targets during
software distribution to clients.

To create a collection for distributing Autodesk software

1

On the Start menu, click Programs (Windows XP) or All Programs
(Windows Vista) » System Management Server » SMS Administrator
Console.

In the SMS console window, in the Tree pane, click the Systems
Management Server folder, and then click the plus sign (+) next to the Site
Database folder.

In the Tree pane, click the Collections folder.

The Name pane displays all the collections that are currently defined.
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4 Right-click the Collections folder. On the shortcut menu, select New »
Collection.

5 In the Collection Properties dialog box, on the General tab, enter a name
for the collection; for example, Autodesk software computers. In the
Comment box, enter any comments you want to add.

You now need to create rules to define what resources will be included in the
collection. You can do this by using either the Query Rule Properties toolbar
button or the Direct Membership Rule wizard.

Create a Rule Using the Query Rule Properties
Toolbar Button

The Query Rule Properties toolbar button adds to a collection all resources
that match a set of criteria specified by the query.

To create a rule using the Query Rule Properties toolbar button

1 In the Collection Properties dialog box, on the Membership Rules tab,
enter a name for the query; for example, All computers with Autodesk
software.

2 Click the Query Rule Properties toolbar button.

3 In the Query Rule Properties dialog box, click Import Query Statement.
A list of available queries is displayed.

4 Select the appropriate query. Start by selecting All Systems, and then click
OK.

In the Query Rule Properties dialog box, you can create or modify a query
statement by clicking Edit Query Statement. Under Collection Limiting,
you can limit the queries assigned to a collection by clicking Limit to
Collection.

5 Click OK.

Your new rule is displayed in the Rules list in the Collection Properties dialog
box.
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Create a Rule Using the Direct Membership Rule
Wizard

The Direct Membership Rule wizard helps you create direct membership rules
for your collection. In contrast to query-based membership rules, which add
all resources that match a set of criteria, the direct membership rules add
specific resources to the collection. To create direct membership rules, you
locate and select the resources you want to add as direct members of the
collection.

To create a rule using the Direct Membership Rule wizard

1 In the Collection Properties dialog box, on the Membership Rules tab,
click the Create Direct Membership Rule Wizard toolbar button.

2 In the Create Direct Membership Rule Wizard dialog box, click Next.

3 In the Search for Resources dialog box, in the Resource Class list, select
System Resource. In the Attribute Name list, select Operating System
Name and Version. In the Value box enter Microsoft Windows
%Workstation%. Click Next.

4 In the Collection Limiting dialog box, click Browse. A list of available
collections is displayed. Select your collection and click OK.

5 In the Collection Limiting dialog box, click Next.

6 In the Select Resources dialog box, a list of all the resources that meet the
criteria of the collection is displayed. Click Select All or select the resources
you want to include. Future resources that meet the criteria of the
collection will be added. Click Next.

7 In the Completing the Create Direct Membership Rule Wizard dialog
box, click Finish.

The new rule is displayed in the rules list in the Collection Properties
dialog box.

Now you must set the start time for the collection.

To set the start time for the collection

1 In the Collection Properties dialog box, on the Membership Rules tab,
click Schedule.
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2 Inthe Schedule dialog box, set the start time for the collection and select
the Recurrence Pattern that will be supplied. Click OK.

3 In the Collection Properties dialog box, click Apply to apply the settings.
Click OK.

4 In the SMS console window, select the Collections folder in the Tree pane.
The new collection is displayed in the Name pane.

Set Up a Source Directory Using the Deployment
Wizard

When you use SMS to deploy Autodesk software, you set up the source
directory using the Deployment wizard. Using the Deployment wizard is an
easy way to create a source directory, and it also ensures that you can upgrade
the setup package in the future. The Deployment wizard creates an
administrative installation image that is used by SMS to deploy the Autodesk
software to the client computers. It also creates a transform file, also known
as the deployment, which must be used during the installation of AutoCAD
Architecture® and AutoCAD Architecture-based products on any client
computers.

In SMS, the location where you perform the administrative installation
becomes the location of the package source directory. When using the
Deployment wizard to create the source directory, you can include additional
files, such as template files, AutoLISP routines, and custom menus. The
Deployment wizard also installs the Deploy executable file (Deploy.exe) that
is used to deploy the software.

To learn more about setting up the source directory for Autodesk software,
see Use the Deployment Wizard.

It is strongly recommended that you test the deployment created by the
Deployment wizard before trying to configure SMS to deploy the program. By
testing the deployment created by the Deployment wizard, you ensure that
there are no problems with the administrative image and deployment.

To test the Deployment wizard deployment

1 Log on to a Windows XP Professional or a Windows Vista workstation
as a user who has administrative privileges.
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2 Navigate to the source directory where the deployment was created. Use
Windows Explorer or Start » Run.

3 Double-click the deployment shortcut created by the Deployment wizard.
The program is installed or an error is written to the network log file.

Create the SMS Software Installation Package

After creating the source directory using the Deployment wizard, you create
the SMS software installation package. An SMS package contains the files and
instructions that SMS uses to distribute the program to SMS clients. The
Deployment wizard creates the files and instructions, but SMS must be
configured to use these files.

To create a software installation package

1 On the Start menu, click Programs (Windows XP) or All Programs
(Windows Vista) » System Management Server » SMS Administrator
Console.

2 In the SMS console window, in the Tree pane, click the Systems
Management Server folder, and then click the plus sign (+) next to the Site
Database folder.

3 In the Tree pane, click the Packages folder.

The Name pane now displays all the installation packages that are
currently defined.

4 Right-click the Packages folder. On the shortcut menu, click New »
Package.

NOTE On the shortcut menu, you cannot select Package from Definition
because the program is not creating a package definition file (PDF or SMS
files).

5 In the Package Properties dialog box, on the General tab, enter the
following information:

B In the Name box, enter a name for the SMS package; for example,
AutoCAD Architecture.

B In the Version box, enter the version of the product you are installing;
for example, 2009.
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B In the Publisher box, enter Autodesk, Inc.

B In the Language box, enter the language of the product you are
installing; for example, English.

B In the Comment box, enter any comments that are specific to your
environment.

Click the Data Source tab.

On the Data Source tab, select the This Package Contains Source Files
option. Click Set.

In the Set Source Directory dialog box, select the Network Path (UNC
Name) option.

Click Browse. Navigate to the source directory created in the Deployment
wizard. Click OK.

The server name and shared folder that you selected are displayed in the
source directory.

NOTE The administrative image you created with the Deployment wizard
should be displayed in the source directory.

In the Set Source Directory dialog box, click OK.
In the Package Properties dialog box, click OK.

In the Tree pane, click the Packages folder.
The Name pane displays the package you created.

Although the package to install the program on SMS client computers has
been created, it still cannot be installed. You must first create the SMS program
for the package.

Create an SMS Program

This section details the configuration options you must use when you create
an SMS program for your Autodesk software. Program configuration options
for deploying software are specified in the Program Properties dialog box in
SMS.

There are two methods for defining the Program configuration options with
Autodesk software. The first method uses the Deploy executable file created
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by the Deployment Wizard for AutoCAD Architecture and AutoCAD
Architecture-based products. The second method uses Windows Installer.

Use the Deploy Executable Method to Create a
Program

The Deployment wizard used to create the administrative image and source
directory for deploying Autodesk software contains an executable file called
Deploy.exe in the Adminlmage folder under the Deployment wizard share.

Deploy.exe is a wrapper for Windows Installer (an executable file that performs
the checks before Windows Installer starts), but it also performs several other
important checks and functions for installing AutoCAD Architecture and
AutoCAD Architecture-based products. Deploy.exe checks the operating system
to ensure that it meets the minimum requirements for installing AutoCAD
Architecture. Deploy.exe also checks to ensure that Windows Installer is version
3.1. If it is not, Windows Installer 3.1 is installed on the client computer.
Deploy.exe is also responsible for writing successful installations and failures
to the network log file specified in the Deployment wizard. It is strongly
recommended that you use this method when deploying AutoCAD Architecture
or AutoCAD Architecture-based products to SMS client computers.

NOTE The Macromedia Flash Player 8 plug-in (which is installed with AutoCAD
Architecture 2009) may cause the SMS 2003 installer to hang.

To create a program using Deploy.exe

1 On the Start menu, click Programs (Windows XP) or All Programs
(Windows Vista) » System Management Server » SMS Administrator
Console.

2 In the SMS console window, in the Tree pane, click the Systems
Management Server folder, and then click the plus sign (+) next to the Site
Database folder.

3 In the Tree pane, click the plus sign (+) next to the Packages folder to
expand it. The defined packages are displayed in the Tree pane. Click the
package you created earlier. In the Name pane, the Access Accounts,
Distribution Points, and Programs folders are displayed.

4 In the Name pane, right-click the Programs folder. On the shortcut menu,
click New » Program.
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5 In the Program Properties dialog box, on the General tab, enter the
following:

B In the Name box, enter a name for the program. The name of the
program must be unique because it is used when defining
advertisements. On client computers, the name is displayed in the
Control Panel, in the Advertised Programs folder.

B In the Comment box, enter any comments you want to add. Text in
the Comment box is displayed on client computers in the Advertised
Programs Monitor dialog box, or in the Advertised Programs wizard
Control Panel applets.

B For the Command Line box, click Browse. Navigate to the source
directory where the deployment was created by the Deployment
wizard. Right-click the deployment shortcut and click Properties. On
the Shortcut tab, in the Target box, select all of the text. Right-click
and click Copy. Click Cancel to exit the Deployment Properties dialog
box. Click Cancel to exit the Open dialog box. In the Program
Properties dialog box, in the Command Line box, right-click, and click
Paste. Your text is displayed.

B In the Run list, select Normal.

B In the After Running list, select No Action Required.

6 Click the Requirements tab. In the Estimated Disk Space box, specify at
least 750 MB. Select the This Program Can Run Only on Specified
Platforms option. Select the following platforms from the list:

m All x86 Windows XP Professional

B x86 Windows Vista

7 Click the Environment tab. In the Program Can Run list, select Only
When a User Is Logged On (In SMS 3.0, you then select the User Input
Required option). Under Run Mode, select the Run with Administrative
Rights option if your users do not have administrative privileges on their
computer. Under Drive Mode, select Runs with UNC Name.

8 Click Apply, and then click OK. In the SMS console window, in the Tree
pane, click the Programs folder to see your new program in the Name
pane.
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Use the Windows Installer Method to Create a

Program

When using the Windows Installer method to configure general program
options for Autodesk software, you must specify command line syntax. The
executable program that interprets packages and installs products is Msiexec.exe.
When using the Windows Installer, no entry is written to the network log
file.

NOTE Before you can deploy Autodesk software on your client computers, you
must ensure that the Windows Installer program (Msiexec.exe) is version 3.1 or
later. The Windows Installer 3.1 setup program is included on your Autodesk
product DVD.

In Windows Installer, in the Program Properties dialog box, on the General
tab, enter the following on the command line:

msiexec options < package> .msi

For AutoCAD Architecture, <package> is aca.msi. The following table lists
several command-line options you will use when deploying the AutoCAD
Architecture package (aca.msi). The command-line options are case sensitive.
For a complete list of options, together with their explanations, consult
Microsoft Windows Installer Help.

Windows Installer Command-line Options

Option Action

/1 Installs or configures a product.

/x Uninstalls a product.

/lev Logfile Specifies the path to log file. The flags indicate which informa-

tion to log. e - All error messages v - Verbose output

/qb- Sets the user interface level.

qb - Basic Ul
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For example, for AutoCAD Architecture use the following syntax: msiexec /I
acad.msi

In addition to using the command-line options, you must use Windows
Installer properties. Properties are global variables used during an installation.
You will need to use the TRANSFORMS property to take advantage of the
transform file created by the Deployment wizard. When used, properties must
be specified as follows:

msiexec options <package>.msi PROPERTY=VALUE

The following table lists several command-line properties. The command- line
options are case sensitive. For a complete list of properties and an explanation
of each, see Microsoft Windows Installer Help.

Windows Installer Command-line Properties

Property Action

TRANSFORMS= List of transforms to be applied to the installation
database (aca.msi).

ACAD_SILENT_LICENSE=YES Silent License Agreement.

INSTALLDIR=

For AutoCAD Architecture, use the following syntax for command-line options
and properties:

msiexec /I <path>\aca.msi TRANSFORMS=<path>\<transform name>.mst /qb-

To use Msiexec.exe to deploy AutoCAD Architecture packages

1 On the Start menu, click Programs (Windows XP) or All Programs
(Windows Vista) » System Management Server » SMS Administrator
Console.

2 In the SMS console window, in the Tree pane, click the Systems
Management Server folder, and then click the plus sign (+) next to the Site
Database folder.

3 In the Tree pane, click the plus sign (+) next to the Packages folder to
expand it. The defined packages are displayed in the Tree pane. Click the
package you created earlier. In the Name pane, the Access Accounts,
Distribution Points, and Programs folders are displayed.
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4 In the Name pane, right-click the Programs folder. On the shortcut menu,
click New » Program.

5 In the Program Properties dialog box, on the General tab, enter the
following:

B In the Name box, enter a name for the program. The name of the
program must be unique because it is used when defining
advertisements. On client computers, the name is displayed in the
Control Panel (Windows), in the Advertised Programs folder.

B In the Comment box, enter any comments you want to add. Text in
the Comment box is displayed on client computers in the Advertised
Programs Monitor dialog box, or in the Advertised Programs wizard
Control Panel applets.

B Inthe Command Line box, enter a command using Windows Installer
command-line syntax. For AutoCAD Architecture, use the following
syntax:

Msiexec /I <path>\aca.msi TRANSFORMS=<path>\<deployname>.mst/qb-

Replace <path> with the source directory or location of your
administrative image that you created with the Deployment wizard. You
must use the UNC naming convention. Replace <deployname> with the
name of the deployment you created with the Deployment wizard. You
must use the .mst file extension.

6 Click the Requirements tab. In the Estimated Disk Space box, specify at
least 750 MB. Select the This List Can Run Only on Specified Platforms
option. Select the following platforms from the list:

B All x86 Windows XP Professional

B x86 Windows Vista

7 Click the Environment tab. In the Program Can Run list, select Only
When a User Is Logged On. Under Run Mode, select the Run with
Administrative Rights option if your users do not have administrative
privileges on their computer. Under Drive Mode, select Runs with UNC
Name.

8 Click Apply, and then click OK. In the SMS console window, in the Tree
pane, click the Programs folder to see your new program in the Name
pane.

The package program has now been created. Next, you must create an
advertisement for the package.
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Create an Advertisement

SMS uses advertisements to distribute SMS programs to SMS client computers.
You create and maintain advertisements by using the SMS Administrator
console window.

To create an advertisement for the package

1

10

11

On the Start menu, click Programs (Windows XP) or All Programs
(Windows Vista) » System Management Server » SMS Administrator
Console.

In the SMS console window, in the Tree pane, click the Systems
Management Server folder, and then click the plus sign (+) next to the Site
Database folder.

In the Tree pane, click the Advertisements folder.

The advertised programs are displayed in the Name pane.

In the Tree pane, right-click the Advertisements folder, and on the shortcut
menu, click All Tasks » Distribute Software.

On the Welcome to the Distribute Software Wizard page of the Distribute
Software wizard, click Next.

On the Package page, select the Distribute an Existing Package option (in
SMS 2003, select the Select an Existing Package option), and then, in the
Packages list, select AutoCAD Architecture. Click Next.

On the Distribution Points page, under Distribution Points, select the
server(s) where the package will be distributed from, and then click Next.

On the Advertise a Program page, under Do You Want to Advertise a
Program to a Collection, select Yes, and then verify that the program you
created earlier is displayed in the Programs list. Click Next.

On the Select Program to Advertise page, under Programs, select a
program, and then click Next.

On the Advertisement Target page, select Advertise the Program to an
Existing Collection, and then click Browse. In the Browse Collection
dialog box, select the collection you created earlier, and then click OK.
On the Advertisement Target page, click Next.

On the Advertisement Name page, in the Name box, enter a name for
the advertisement. In the Comment box, enter any comments you want
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to add. The name and comments are displayed on the client computer.
Click Next.

12 On the Advertise to Subcollections page, you can specify whether the
advertisement should also be applied to subcollections. Select the option
for your advertisement, and then click Next.

13 On the Advertisement Schedule page, select Yes or No, depending on
whether or not you want the advertisement to expire. Select the expiration
date and time, if applicable. Click Next.

14 On the Assign Program page, select Yes or No, depending on whether
you want to assign the program. An assigned program runs automatically
if it has not already been run on the SMS client. If you select Yes, you
must enter a date and time for when the program becomes assigned. Click
Next.

15 On the Completing the Distribute Software Wizard page, click Finish. In
the SMS console window, in the Tree pane, click the Advertisements folder
to see your new program in the Name pane.

The Autodesk software is ready to be installed on an SMS client computer.

Install Autodesk Software on the Client Computer

To install the Autodesk software, log on to a computer with the SMS client

software installed. The computer must be part of the domain being serviced
by the SMS server. If you did not select Run with administrative rights when
creating the program, you need to log on to the computer as an administrator.

You can verify that the computer has the SMS client software installed by
checking for three Control Panel applets: Systems Management, Advertised
Programs, and Advertised Programs Monitor.

NOTE In Windows XP, you will not see these applets until you switch Control
Panel to Classic View.

To install the program on the SMS client computer
1 On the Start menu, click Control Panel.

2 In the Control Panel, double-click Advertised Programs.
The Advertised Programs wizard is started.
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3 On the Welcome to the Advertised Programs Wizard page, click Next.

4 On the Select Programs to Run page, under Advertised Programs, select
the advertised Autodesk program, and then click Next.

5 On the Run Programs Now or Later page, select the Run the Selected
Program Now option, and then click Next.

6 On the Completing the Advertised Programs Wizard page, click Finish.

The Autodesk software program has been installed with SMS. To explore other
methods for installing Autodesk software using SMS, and to read more about
the advanced features of SMS, consult the SMS documentation.

Install Autodesk Software on the Client Computer | 99



100



Distribute the Product
Using Imaging Software

The following information is provided for those who use imaging software, such as Norton
Ghost, to create a master image to distribute Autodesk products. Once created, the master
image is then replicated to other computers throughout your facility.

Care needs to be taken since the use of imaging software can result in the following situations:
m Conflicts with the product licensing

B Incomplete installations and problems with activation

NOTE If you are experiencing licensing instability in a SATA RAID environment, using
imaging software to distribute Autodesk products can cause product activation problems,
such as “Activation code limit exceeded” when you attempt to activate.

Use a Master Image to Distribute Multi-Seat
Stand-Alone Products to Multiple Systems

You can distribute the product using a master image for a multi-seat stand-alone
product.

NOTE When using Norton Ghost, you must use the -ib switch to include the boot
sector in your master image. Consult your imaging software for more details on
including the boot sector as part of the master image.

Master images should not be created if you've previously run Autodesk products
on the master computer. Cleaning the system may be necessary. See Clean a
Master System and Restore the Operating System on page 104.
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To distribute a multi-seat stand-alone product to multiple computers
using a master image

1 Create a network deployment for a multi-seat stand-alone product. For
more information, see Use the Installation Wizard to Set Up a Deployment
on page 31.

2 Install the Autodesk product from the deployment onto the master
computer.

3 Do one of the following on the master computer:

B Create a master image, including the boot sector. Test the product on
a machine other than the master computer before distributing the
product. Launch the product on the other machine, and register and
activate it. Users have a 30-day grace period to register and activate
the product on their machines.

B Launch and customize the product as necessary. Create a master image
and distribute it to users. If users’ computers are connected to the
Internet, the product is automatically activated. Users whose
computers are not connected to the Internet have a 7-day grace period
to register and activate the product.

4 Apply the master image to the target computers.

Use a Master Image to Distribute Network
Licensed Products to Multiple Systems

You can distribute the product using a master image for a network licensed
product.

To distribute a network licensed product to multiple computers using
a master image

1 Create a network deployment for a network licensed product. For more
information, see Use the Installation Wizard to Set Up a Deployment on
page 31.

2 Install the Autodesk product from the deployment onto the master
computer.
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NOTE A license server must be running, and each computer must be
connected to the network in order for the product to obtain a license.

After the Autodesk product has been installed, use imaging software to
create a master image of the system's hard drive.

4 Apply the master image to the target computers.

Restore the Master Image

The following procedure assumes that you have saved a copy of each
workstation’s Software Licenses folder (and Product Licenses folder, if present)
to either another workstation or a DVD before you reformat the workstation.

To restore a product using a master image

1

Exit the application. Do not run the application again until after you
have completed this procedure.

In Windows Explorer, copy the Software Licenses folder from the
appropriate path shown below to a location other than the disk that will
be restored.

C:\Documents and Settings\All Users\Application Data\ Autodesk \Software
Licenses

Reformat the workstation and restore the master image.

NOTE Do not perform a low-level format of the hard drive.

Copy the Software Licenses folder that you created in step 2 to its original
workstation and location on that workstation.

NOTE When you restore the disk image, any files that were altered are put back
in their original state and ready to use again. The license files are preserved, and
no reactivation of products is necessary.
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Clean a Master System and Restore the
Operating System

If you have already run the Autodesk product on the master computer, the
master computer should be properly cleaned first.

To clean a master computer and restore the operating system

1 Clean the hard drive, including the boot sector.

For example, if you use Norton’s GDISK utility, use the following
command:

gdisk 1 /diskwipe
Where 1 is the hard disk that is being wiped.

NOTE If you use a utility other than Norton Ghost, make sure that it cleans
the boot sector; otherwise, you will not be able to activate Autodesk products.

2 Create a new partition and use the restore CD or product CD to install
the operating system.
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Glossary

activate Part of the Autodesk software registration process, it allows you to
run a product in compliance with the product's end-user license agreement.

Active Directory A directory service from Microsoft that is part of Windows
2000 and Windows 2003 Server.

administrative image A collection of shared file resources created by the
Deployment wizard and used by deployments to install the program to network
workstations. Service packs (patches) can be applied to an administrative image
using the Deployment wizard.

advertising A pull technology that notifies users of an updated software
product that is available for installation. Users typically double-click a shortcut
(or do a similar operation) to complete the installation of the advertised
product.

AutoCAD Architecture startup accelerator (acstart17.exe) A runtime process
that can accelerate the initial startup of AutoCAD Architecture.

deploy The process of installing an Autodesk product to one or more
computers on a network.

deployment A link to a unique MST (Microsoft Transform) file that serves as
a basis for an installation. Using the Deployment wizard, administrators can
create multiple deployments that result in different types of installations for
users.

directory service A network service that identifies all resources on a network
and makes them accessible to users and applications. Resources include email
addresses, computers, and peripheral devices such as printers. Ideally, the
directory service should make the physical network topology and protocols
transparent so that a user on a network can access any resource without
knowing where or how it is physically connected. Virtually all directory services
are based on the X.500 ITU standard.

FLEXIm License management technology from Macrovision Software, Inc.
FLEXIm provides administrative tools that help to simplify management of
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network licenses. FLEXIm can be used to monitor network license status, reset
licenses lost to a system failure, troubleshoot license servers, and update
existing license files.

group policy Microsoft server technology that provides a way to do push
installations and advertising-based installations using standard Microsoft 2000
Server administration components.

installation image A deployment that consists of an MSI file, any associated
transforms, additional user-specified custom files, and profile and registry
settings.

MSI Microsoft installer that supports a variety of parameters that can be
scripted.

MSP Microsoft patch file (see patch).

MST Microsoft transform file. Modifies the components installed by the MSI
file. For example, the Deployment wizard creates an MST file with the settings
that you specify. The deployment created by the Deployment wizard uses the
MST file in conjunction with the MSI file and MSIEXEC to install the program
on local workstations.

multi-seat stand-alone installation A type of installation where multiple
stand-alone seats of the program are installed using a single serial number.

partial profile A profile that contains partial registry information
corresponding to a subset of the options available from the Files tab of the
Options dialog box.

patch A software update to an application.

power user A user with rights to access and write to the Program Files folder
and the HKEY_Local_Machine folder of the registry.

pull technology An installation technology that requires user interaction to
complete the installation.

push technology An installation technology that installs files to a remote
desktop without any user interaction.

scripting The process of using scripting languages such as VB Script to facilitate
the deployment of software packages.

service pack Autodesk terminology for an application patch.

silent installation An installation that proceeds without any explicit user
input. No dialog boxes are presented that require interaction from the user.
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SMS Microsoft Systems Management Server. A tool that helps administer
networked machines by allowing remote configuration, push deployments,
and user administration. SMS is an expensive technology that must be
purchased as an additional server.

transform See MST.
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